# Table of Contents

### Introduction 7

### Chapter 1: What's New? 9
- New Features in Version 10.1.0 9
- New Human Tasks 9
- New Features in Version 8.3 9
  - Notification of System Issues 9
  - Web Service Tasks Support All Common Types 9
  - Default Actions for Agent Items 10
  - Task-Level Filters in Agent Tasks 10
  - Resubmitting Failed Agent Tasks 10
  - Running a Task on Agent Failure 10

### Chapter 2: IBM Cognos Event Studio 11
- Building IBM Cognos Business Intelligence Applications 13
- The IBM Cognos Event Studio Window 14
  - Insertable Objects Area 15
- Example - Create an Agent with a Single Task 16
- Events 16
  - Event Instances 16
  - Event List 17
  - Event Key 17
  - Task Execution Rules 17
- Agents 18
  - Example - Create an Agent with Multiple Tasks 19
  - Prompting Agents 19
  - Agent Views 19
- Tasks 19
  - Task Frequency 20
- Notification Methods 20
  - How Multiple Events Affect E-mail Messages, Approval Requests, and Notification Requests 22
- The Great Outdoors Company Samples 22
- IBM Cognos Event Studio Samples 23
  - The Customer Contact Sample 24
  - The Returns Agent Sample 24
  - The ELM Returns Agent Sample 24
  - The ELM Escalation Agent Sample 24
- Example - Managing the Life Cycle of an Event 24
  - Example - Configure Your Mail Server 25
  - Example - Modify the Agent Samples to Send E-mails to You 25
  - Example - Simulate the Occurrence of Initial Events 26
  - Example - Preview the Output of Each Task of an Agent 27
  - Example - Detect Initial Events and Act on Them 27

Licensed Materials – Property of IBM
© Copyright IBM Corp. 2005, 2010.
Table of Contents

Example - Simulate the Passage of Time and the Resolution of Some Events 28
Example - Detect an Ongoing Unresolved Event and Escalate the Issue 29
Example - Confirm that the ELM Escalation Agent Sample Completed Its Tasks Successfully 30

Chapter 3: Creating an Agent 31
Specify an Event Condition 32
  Define a Parameter 33
  Define a Calculation 33
Adding Tasks 34
  Add an E-mail Task 34
  Add a News Item Task 35
  Add a Report Task 37
  Add a Job Task 39
  Add an Agent Task 40
  Add an Approval Request Task 41
  Add a Notification Request Task 45
  Add a Database Update Task 47
  Add a Web Service Task 47
  Add an Export Task 49
  Add an Import Task 49
  Add a Content Maintenance Task 50
  Add a Metric Task 51
  Add a Planning Macro Task 51
  Add a Migration Task 52
Specify the Task Execution Rules 52
Preview the Data 53
Create a Schedule for an Agent 55
Specify Default Options for an Agent 56
Allow Users to Subscribe to the Alert List of the Agent 56
Change the Order in Which to Run Tasks 57
Modify an Event Condition 58
Modify or Delete a Task 58
Modify the Task Execution Rules 58
Test an Agent 59
Preparing to Run a Web Service Task 59
  Generating a Java Object File 59
  Registering the Domain Name 60
Run an Agent 61
  Remove Previous Event Instances for an Agent 62
Working With Agents in IBM Cognos Connection 62

Chapter 4: Tutorial - Creating an Agent 63
Start IBM Cognos Event Studio 64
Define a Parameter 64
Define a Calculation 65
Specify an Event Condition 66
Add a Report Task 67
Change the Task Execution Rules for a Report Task 68
Add an Approval Request Task 69
Add an E-mail Task 70
Change the Task Execution Rules for an E-mail Task 71
Add a News Item Task 72
Schedule an Agent 73
Save an Agent 73
Run an Agent 74

Chapter 5: Troubleshooting 75
A Report Link in an Email Notification Does Not Work 75
The Page Cannot Be Found Error Appears When Viewing Report Outputs from Email Links 75
Metadata Change in Oracle Essbase Not Reflected in Reports and in the Studios 75
Errors When Running Web Service Tasks 75

Glossary 77

Index 79
**Introduction**

This document is intended for use with IBM® Cognos® Event Studio. Event Studio is a web-based product for creating and managing agents that monitor data and perform tasks when the data meets predefined thresholds.

This document describes how to use Event Studio to ensure that critical information is detected quickly and delivered to key stakeholders in your business.

**Audience**

To use this guide, you should have

- Knowledge of your business requirements
- Knowledge of business analysis concepts
- Knowledge of databases and data modeling concepts

**Finding information**

To find IBM® Cognos® product documentation on the web, including all translated documentation, access one of the IBM Cognos Information Centers at http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp. Updates to Release Notes are published directly to Information Centers.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

**Using quick tours**

Quick tours are short online tutorials that illustrate key features in IBM Cognos product components. To view a quick tour, start IBM Cognos Connection and click the Quick Tour link in the lower-right corner of the Welcome page. Quick Tours are also available in IBM Cognos Information Centers.

**Accessibility features**

This product does not currently support accessibility features that help users with a physical disability, such as restricted mobility or limited vision, to use this product.

**Forward-looking statements**

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.
Introduction

**Samples disclaimer**

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 1: What’s New?

This section contains a list of new features for this release. It will help you plan your upgrade and application deployment strategies and the training requirements for your users.

For an overview of new features for this release, see the IBM® Cognos® New Features Guide.

For changes to previous versions, see "New Features in Version 8.3" (p. 9).

To review an up-to-date list of environments supported by IBM® Cognos® products, such as operating systems, patches, browsers, web servers, directory servers, database servers, and application servers, visit the IBM® Cognos® Resource Center (http://www.ibm.com/software/data/support/cognos_crc.html).

New Features in Version 10.1.0

Listed below are new features since the last release. Links to directly-related topics are included.

New Human Tasks

There are two new human tasks that you can create in IBM® Cognos® Event Studio:

- approval request tasks
- notification request tasks

For more information, see "Add an Approval Request Task" (p. 41) and "Add a Notification Request Task" (p. 45).

New Features in Version 8.3

Listed below are new features since the last release. Links to directly-related topics are included.

Notification of System Issues

You can now set up notifications that can be delivered based on specific system events. Because constant monitoring of an environment is not practical, use IBM® Cognos® Event Studio to create an agent to look for violations of system metric thresholds. When a threshold is crossed, the agent can follow a specified course of action, such as sending an e-mail, running a report or calling a web service to perform a specific action.

Web Service Tasks Support All Common Types

In IBM® Cognos® Event Studio, web service tasks for agents now support all the common types of web service definitions, including document literal wrapped. You can also pass all agent data to the target Web service in a single call. For example, instead of just string, numeric, or date data
types, you can pass complex data structures, arrays, enumerations, and even a data type that wraps a simple type. You no longer must call a web service multiple times to pass multiple records.

**Default Actions for Agent Items**

You can now choose a default action to use when an agent item is selected in IBM® Cognos® Connection, rather than automatically opening the agent in IBM® Cognos® Event Studio. The new choices are

- show the most recent event list
- run the agent
- open the agent in Event Studio

The default action is defined on the Agent tab of the item properties in IBM® Cognos® Connection.

**Task-Level Filters in Agent Tasks**

The tasks run by an agent can now be based on the data values of an event in addition to its status. The run decision can be further qualified by examining data values within the event. For example, for the event Order Requires Approval, new orders valued less than 1,000 can invoke the Normal Approval task while new orders valued greater than or equal to 1,000 can invoke the Special Approval task.

To achieve this previously, it was necessary to run two agents to check for order values either greater than/equal to or less than 1,000. Adding the task-level filter reduces load on the target data source.

The new options to specify the task-level filters appear in the task execution rules dialog box.

**Resubmitting Failed Agent Tasks**

Failed agent tasks can now be resubmitted with their original data values. Previously, if a task failed, the data passed to the task was lost. Rerunning the agent may not solve this problem if the task is set to process new events only.

Failed agent tasks can be resubmitted from the run history, accessed from the Past activities page of IBM® Cognos® Administration, or accessed from the Actions page of the item.

**Running a Task on Agent Failure**

You can add a special on-error task to an agent. This task runs if the final state of the agent is Failed. The on-error task is considered separate from the agent and is not included in its run history.

An on-error task can be set to run if either the query or one of the tasks of the agent fails. The on-error task has access to the run history for the agent and therefore can be used to notify a user or administrator of the failure. This notification can include details such as the ID of the agent, the run time, and any error messages returned.

The on-error task is defined using a new option in the task execution rules dialog box.
Chapter 2: IBM Cognos Event Studio

Use IBM® Cognos® Event Studio to notify decision-makers in your organization of events as they happen, so that they can make timely and effective decisions.

You create agents that monitor your organization’s data to detect occurrences of business events. An event is a situation that can affect the success of your business. An event is identified when specific items in your data achieve significant values. Specify the event condition, or a change in data, that is important to you. When an agent detects an event, it can perform tasks, such as sending an e-mail, adding information to the portal, and running reports.

For information about how to use Event Studio, see "Creating an Agent" (p. 31).

Note: Some of the features available in Event Studio are not compatible with Firefox. For this reason, you are recommended to use Microsoft® Internet Explorer web browser.

You can follow a tutorial that shows you how to create and run an agent in response to a business scenario. For more information, see "Tutorial - Creating an Agent" (p. 63).

Source Items
IBM® Cognos® Event Studio works with source items that were defined in an IBM® Cognos® Framework Manager model and published as a package to IBM® Cognos® Connection. Source items are used to specify an event condition that is monitored by the agent. You can also use source items to derive calculations or parameters that may be included in the event condition.

To use Event Studio effectively, you should be familiar your organization's business and its data. You may also need to be familiar with other components of IBM® Cognos® Business Intelligence.

IBM Cognos Report Studio
IBM® Cognos® Report Studio is the professional reporting tool for IBM® Cognos® Business Intelligence. Use it to author more complex reports.

Report Studio offers greater flexibility in calculating and formatting results. Report authors can open IBM® Cognos® Query Studio reports to create more advanced reports.

Report Studio gives users access to the full range of Report Studio functionality. Use Report Studio to create any report type, including charts, maps, lists, and repeaters, using any data source (relational or multi-dimensional).

IBM Cognos Business Insight
IBM® Cognos® Business Insight is a new report consumption tool that provides an integrated business intelligence experience for business users. This web-based tool allows you to use IBM® Cognos® content and external data sources to build sophisticated interactive dashboards that facilitate collaborative decision making.
Chapter 2: IBM Cognos Event Studio

**IBM Cognos Business Insight Advanced**

IBM® Cognos® Business Insight Advanced provides a simple and focused report authoring interface. It is designed for business users to create reports that analyze corporate data according to specific information needs. When you are consuming reports using IBM® Cognos® Business Insight, and you want to edit the report or author a new report, use Business Insight Advanced to do so.

This new report authoring tool replaces IBM® Cognos® Report Studio Express.

**IBM Cognos Connection**

IBM® Cognos® Connection is the web portal for IBM® Cognos® Business Intelligence. Use the portal to store and access your reports. If you have the necessary permissions, you can also use the portal for report administration, including scheduling and distributing reports.

Administrators use the portal to administer servers, optimize performance, and specify access permissions.

**IBM Cognos Framework Manager**

IBM® Cognos® Framework Manager is the data modeling tool for IBM® Cognos® Business Intelligence.

The packages you use to generate reports are based on models that are created in Framework Manager. A model is a set of related objects, such as query subjects, dimensions, filters, and calculations. When you open a package in IBM® Cognos® Business Intelligence, these model objects are visible in the left frame.

**IBM Cognos Analysis Studio**

IBM® Cognos® Analysis Studio is the analysis tool for IBM® Cognos® Business Intelligence. Use it to explore, analyze, and compare dimensional data.

Analysis Studio helps you answer business questions by finding meaningful information in large data sources.

**IBM Cognos Metric Studio**

IBM® Cognos® Metric Studio is the metrics tool for IBM® Cognos® Business Intelligence. Use it to create scorecard applications and monitor the metrics within them.

Metric Studio helps you translate your organization’s strategy into relevant, measurable goals that align each employee’s actions with a strategic plan.

**IBM Cognos Query Studio**

IBM® Cognos® Query Studio is the reporting tool for creating simple queries and reports in IBM® Cognos® Business Intelligence, the web-based reporting solution. In Query Studio, you can view data, create reports, change the appearance of reports, and work with data in a report.
Building IBM Cognos Business Intelligence Applications

The lifetime of an IBM® Cognos® Business Intelligence application can be months, or even years. During that time, data may change and new requirements appear. As the underlying data changes, authors must modify existing content and develop new content. Administrators must also update models and data sources over time. For more information about using data sources, see the IBM Cognos Administration and Security Guide and the IBM Cognos Framework Manager User Guide.

In a working application, the technical and security infrastructure and the portal are in place, as well as processes for change management, data control, and so on. For information about the workflow associated with creating IBM Cognos BI content, see the IBM Cognos Architecture and Deployment Guide. For additional information, see the IBM Cognos Solutions Implementation Methodology toolkit, which includes implementation roadmaps and supporting documents. Information about the toolkit is available on www.ibm.com.

The following graphic provides an overview for how to use IBM Cognos BI to build applications across all of your IBM Cognos BI components.

- **Locate and prepare data sources and models**
  IBM Cognos BI can report from a wide variety of data sources, both relational and dimensional. Database connections are created in the Web administration interface, and are used for modeling, for authoring, and for running the application.

  To use data for authoring and viewing, the business intelligence studios need a subset of a model of the metadata (called a package). The metadata may need extensive modeling in Framework Manager.

- **Build and publish the content**
  Reports, scorecards, analysis, dashboards and more are created in the business intelligence studios of IBM Cognos BI. Which studio you use depends on the content, lifespan, and audience of the report, and whether the data is modeled dimensionally or relationally. For example, self-service reporting and analysis are done through IBM Cognos Business Insight Advanced, IBM Cognos Query Studio, and IBM Cognos Analysis Studio, and scheduled reports are created in IBM Cognos Report Studio. Report Studio reports and scorecards are usually prepared for a wider audience, published to IBM Cognos Connection or another portal, and scheduled there for bursting, distribution, and so on. You can also use Report Studio to prepare templates for self-service reporting.

- **Deliver and view the information**
  You deliver content from the IBM Cognos portal or other supported portals, and view information that has been saved to portals, or delivered by other mechanisms. You can also run reports, analyses, scorecards, and more from within the business intelligence studio in which they were created.

The IBM Cognos Event Studio Window

Use the IBM® Cognos® Event Studio window to interactively create and manage agents.

The Event Studio window is made up of four areas:

- the I want to area
  This area shows the main tasks that you perform when you create an agent.

- the Insertable Objects area
  This area shows available source items, data items used by the current agent, functions you can insert in the event condition, and parameters you created.

- the summary area
  This area contains tabs with summary descriptions of the event condition and of each task defined for the agent.

- the content area
  This area contains the pages and dialogs that you use to create and manage an agent.

The four areas are shown in the following example.
I want to area

Summary area

Insertable Objects area

Content area

Insertable Objects Area

The Insertable Objects area contains items that you can add to the event condition and tasks. There are several tabs along the bottom of this area.

The Source Tab

The source tab shows a hierarchical list of the source items, both relational and dimensional, in the model package.

The Data Items Tab

The data items tab shows a list of all the data items contained in the agent. The data items tab also shows the calculations used in the agent.
**The Functions Tab**

The functions tab shows a list of mathematical functions, such as operators and summaries, that you can use in event conditions and to create calculated data items.

**Tip:** If you are specifying an event condition and want to know the meaning of a function icon, click the icon and read the description in the Information box.

**The Parameters Tab**

The parameters tab shows a list of each parameter you defined, indicated by the parameter icon. You can use parameters when specifying the event condition.

**The Run History Tab**

The run history tab shows a list of items you can specify when you add an on-error task to an agent.

### Example - Create an Agent with a Single Task

You create an agent to perform a task when it detects a business event.

You are a sales manager who wants to ensure that your most valued customers are pleased with the quality of service they receive.

You decide that, whenever a valued customer calls your support group, you will call the customer the next day to make sure they’re satisfied. You use IBM® Cognos® Event Studio to create an agent that monitors support call records. You specify an event condition as follows:

\[
[\text{Call}\_\text{Status}] = \text{Open} \text{ AND } [\text{Customer}\_\text{Profile}] = \text{Gold}
\]

Next you add a task and specify that, when the event occurs, the agent sends you an e-mail entitled Urgent: Call Customer Today.

The e-mail message you receive contains details both about the customer and about the call. You do not need to continually check the call system or run reports. The relevant data is sent to you only when you need to act upon it.

### Events

An event is an exceptional item of data, defined by specifying a query expression against items in a data package. When a record matches the event condition, it causes an agent to perform tasks.

When an agent runs, it checks the data for any event instances.

For example, you can specify an event condition as follows:

\[
[\text{Account}\_\text{Balance}] < 0
\]

### Event Instances

An event instance is a single row of data that matches the event query expression. When an agent monitors data, it detects each event instance. The agent then follows the task execution rules to determine if it should perform a task.
Some types of tasks are performed only once by the agent. Other types of tasks are repeated for each event instance. For more information, see "Task Frequency" (p. 20).

**Event List**

An event list shows the events processed by the agent. Each event is categorized by one of the following statuses:

- new
- ongoing but changed
- ongoing and unchanged
- ceased

When an agent runs, it derives the status by comparing the detected events with those detected in the previous run. There is only one event list per agent, and it is updated each time the agent runs.

For each task in an agent, the event list is checked against the task execution rules (p. 17). The task is performed for each event that conforms to the rules.

**Event Key**

An event key is used to determine whether an event is new, ongoing but changed, ongoing and unchanged, or ceased. IBM® Cognos® Event Studio compares the event instances detected in each agent run with those detected in the previous run. To ensure it correctly matches the event instances for comparison, you must define an event key. The event key is the combination of data items that uniquely defines an event instance.

For example, you are dealing with orders that were placed for out-of-stock goods. You define `Order Number` as the event key, because each order placed has a unique number. If `Order Number 1234` appears in this run and in the previous run, it is an ongoing event. If `Order Number 4567` appears in this run, but not in the previous run, it is a new event. If `Order Number 7890` appeared in the last run but not this one, it has ceased.

**Task Execution Rules**

When an agent runs, it uses the event key (p. 17) to compare the event instances it detects with those of the previous run. The agent allocates a status to each event - new, ongoing but changed, ongoing and unchanged, or ceased. If no event instances are detected, the status is no events. The task execution rules specify the event status for which each task is performed. You can optionally specify that an event must also pass a Boolean test before it is used in a task. If you do not set any execution rules, the agent performs its tasks for all the event instances it detects.

You can also set a special task to execute if the agent fails, for example, if the agent condition fails or one of the agent’s tasks fails to complete. This special task can include items from the agent’s run history, such as its run time, status, and error messages.
Example - Event Status of New

You want to receive an e-mail message advising you whenever a Gold category customer phones technical support about a new problem.

You specify that an e-mail task be performed only when the event status is new. You receive an e-mail when the call record from a Gold customer is first placed in the call database. However, even if the call record is still open the next time the agent runs, you receive no further e-mails because the status of the event is now ongoing.

Example - Event Status of Ongoing But Changed

You want a report to run if the account balance of an overdrawn customer changes.

You specify that a report task be performed only when the event status is ongoing but changed.

Example - Event Status of No Events

You want to receive a daily e-mail that reassures you that none of your company’s accounts has a balance less than zero.

You define the following event condition:

\[
[\text{Account}_\text{Balance}] < 0
\]

You specify that an e-mail task be performed if the event status is no events.

In this example, you may also want to create another task that sends an urgent e-mail if any of the account balances does become less than zero. That is, you create another e-mail task that is performed if the event status is new.

Example - Task-Level Boolean Filter

You want to e-mail your Regional Managers whenever a very large order is received from a customer in their territory.

You create four calculated data items containing Boolean expressions:

- **Item IsNorth**: If ([Region] = ‘North’) then (‘True’) else (‘False’)
- **Item IsEast**: If ([Region] = ‘East’) then (‘True’) else (‘False’)
- **Item IsSouth**: If ([Region] = ‘South’) then (‘True’) else (‘False’)
- **Item IsWest**: If ([Region] = ‘West’) then (‘True’) else (‘False’)

Add four e-mail tasks to the agent, one addressed to each Regional Manager. Add the appropriate task-level filter to each task. In this example, the task that e-mails the Northern Regional Manager includes only orders that pass the test Region = ‘North’.

Agents

Agents monitor data for instances of an event (p. 16) and perform tasks when events occur. These tasks can help to notify people about events immediately, so that they can make timely and effective decisions.
When an agent runs, it checks for occurrences of the event. If it detects the event, the agent performs its tasks for events that meet the execution rules (p. 17). An agent runs its tasks either all at the same time or in the order that you specify.

**Example - Create an Agent with Multiple Tasks**

You are a meteorological analyst who wants to be alerted to extreme drops in air pressure that could result in a violent storm.

You create an agent named Pressure_Drop. You specify the event condition as follows:

\[
[Air\_Pressure]\_\{Current\_Time-60\} - ([Air\_Pressure]\_\{Current\_Time\}) > 5.0
\]

Next, you add an e-mail task and specify that, when the event occurs, the agent sends you an e-mail entitled **Pressure Drop Alert**. Finally, you add a report task that sends a report of the latest air pressure readings to people in surrounding weather offices.

**Prompting Agents**

A prompting agent prompts a user to specify values for the event condition. This can result in the task being performed in a situation that is specific to the user.

For example, you specify an event condition that prompts sales managers to specify their region and their product. The task is then performed only for events that are of interest to the sales manager who is running the agent.

The prompts of an agent can also be answered by passing in the values of source items from the events of another agent.

**Agent Views**

You can use IBM® Cognos® Connection to create an agent view. Agent Views are used to share the agent specification. However, you can run an agent view using different prompt values if it is a prompting agent, or following a different schedule.

For more information, see the IBM® Cognos® Connection **User Guide**.

**Tasks**

An agent can perform one or more tasks that you define for it. You can use some tasks to notify the right people quickly about a change in a business event so they can take appropriate action. Other tasks can help you to automate a work flow.

An agent can perform its tasks all in sequence or all in parallel. That is, you can specify that each task is performed in the order you choose. Or you can specify that tasks be performed at the same time.

You can specify tasks that do the following:

- send an e-mail (p. 34)
- publish a news item (p. 35)
- run a report (p. 37)
- run a job (p. 39)
- run an agent (p. 40)
- send an approval request (p. 41)
- send a notification request (p. 45)
- update a database (p. 47)
- call a web service (p. 47)
- run an export (p. 49)
- run an import (p. 49)
- run a content maintenance task (p. 50)
- run a metric task (p. 51)

**Task Frequency**

Before you specify an event condition, you should understand how often different tasks are performed.

<table>
<thead>
<tr>
<th>Task type</th>
<th>Number of times performed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run a report; run an agent; run a job; run an import; run an export; run a content maintenance task</td>
<td>Once</td>
</tr>
<tr>
<td>Update a database; call a web service</td>
<td>Once per event instance</td>
</tr>
<tr>
<td>Send an e-mail; send an approval request; send a notification request</td>
<td>Variable</td>
</tr>
<tr>
<td></td>
<td>For more information, see &quot;How Multiple Events Affect E-mail Messages, Approval Requests, and Notification Requests&quot; (p. 22).</td>
</tr>
<tr>
<td>Publish a news item</td>
<td>Once</td>
</tr>
</tbody>
</table>

**Notification Methods**

If you want to notify people about a business event, you should understand the notification methods that an agent can use. The notification method you choose should contain all information relevant to the event, and each person who must know about the event should be notified.

An IBM® Cognos® Event Studio agent can notify people about business events by
- delivering an e-mail to your audience
• publishing a news item to a folder frequently viewed by your audience

The notification feature can contain dynamic information. This means that source items from a package can be inserted into the message. The values for these items are not retrieved until the agent is run because a notification message about a critical data item always contains the current values.

Both e-mail and news item notifications can contain dynamic information. In an e-mail task, the e-mail can contain dynamic content in the list of recipients, the subject, and the message body. For more information, see "Add an E-mail Task" (p. 70).

The parts of a news item notification that can contain dynamic content are the headline, the screen tip, and the text. For more information, see "Add a News Item Task" (p. 72).

Although e-mail and news item notifications can both show content dynamically, only e-mail notifications can change their target dynamically. By inserting e-mail address items in the recipient fields, you can specify that the recipient list change according to the data in the event list.

**E-mail Notifications**

You can notify people by e-mail using either a report task or an e-mail task. To help you decide which method to use, you should understand how they differ.

You can use either a report task or an e-mail task

• to send a single e-mail text message

• to attach a single report in the specified output formats
  
  If you attach only one HTML report and leave the body field empty, the report appears in the message body.

• to add links to a single report for the specified output formats

For an e-mail task but not a report task, you can also

• add dynamic content to the message, which may result in multiple e-mails
  
  This means that you can insert source items from a package into the message. If you insert an e-mail address item in the recipient fields, you can tailor the recipient list so that it is specific to the data in the message.

• send multiple reports in a single e-mail as attachments, links, or both
  
  For example, you can attach a report about stock usage and a report on unfulfilled customer orders when a particular stock item falls below a reorder level.

• attach the event list

E-mailing reports from an IBM® Cognos® Event Studio agent is useful if you want the report to be tailored to a specific event. However, if you want to regularly send a report by e-mail that is not related to an event, you do not need to create an agent. You can send it by e-mail from IBM® Cognos® Connection. For more information, see the IBM® Cognos® Connection User Guide.
News Item Notifications

A news item task publishes a headline to a folder whose contents can be viewed in an IBM® Cognos® Navigator portlet and in any folder view. When someone clicks on a headline, they can open IBM® Cognos® Business Intelligence content or view a web page.

How Multiple Events Affect E-mail Messages, Approval Requests, and Notification Requests

When you create an e-mail message, approval request or notification request, you can drag data items into the recipient, subject, and message body fields. These data items act as placeholders. When the agent runs, the placeholders are replaced with actual values from the data source.

If data items appear only in the message body, a single message is usually sent containing details of all the events detected. If the recipient or subject fields include data items, many e-mails or requests may be sent.

For an example that illustrates the effect of multiple events, see "Add an E-mail Task" (p. 70).

Dynamic Address

For some e-mails or requests, the appropriate recipient depends on the values in the event. For example, an e-mail about a support call from Customer A must be addressed to Customer A’s account manager.

If the data source includes an item that represents e-mail addresses, you can drag this item to the recipient fields. The agent uses this data to generate the e-mail address dynamically. If the agent detects several events that satisfy the event condition, it generates one message or request for each e-mail address. The source items in the message body are grouped by address.

Dynamic Subject

If you include a source item in the subject field, the agent generates one message or request for each subject. The source items in the message body are grouped by subject.

Dynamic Address and Dynamic Subject

If you include source items in both the address and subject fields, the messages or requests are grouped by address and subject.

Dynamic Message Body

If an agent detects several events that satisfy the event condition, the size of the message body in the delivered message or request can increase. Every line that contains a data item placeholder is repeated for each event instance that satisfies the task execution rules.

The Great Outdoors Company Samples

The Great Outdoors Company samples illustrate product features and technical and business best practices. You can also use them for experimenting with and sharing report design techniques and for troubleshooting. As you use the samples, you can connect to features in the product.
For examples related to different kinds of businesses, see the product blueprints at www.ibm.com. For information about specific installation choices and environments, see the IBM® Cognos® Architecture and Deployment Guide, or the Proven Practices and the IBM Cognos Implementation Roadmaps on www.ibm.com. For information about audit samples, see the IBM Cognos Administration and Security Guide. For information about Mobile samples, see the IBM Cognos Mobile Installation and Administration Guide.

The Great Outdoors Company, or GO Sales, or any variation of the Great Outdoors name, is the name of a fictitious business operation whose sample data is used to develop sample applications for IBM and IBM customers. Its fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values, is coincidental. Unauthorized duplication is prohibited.

Where to Find the Samples
The samples are included with the product and the samples for each studio are described in the related user guide and online help. To use the samples, you must install, set up, and configure them or contact your administrator to find out where they are installed. For instructions on how to install the samples, see the IBM Cognos Installation and Configuration Guide. For instructions on how to set up and configure samples, see the IBM Cognos Administration and Security Guide or the IBM Cognos Installation and Configuration Guide.

Samples Outline
The samples consist of the following:

- Two databases that contain all corporate data, and the related sample models for query and analysis
- Five samples cubes and the related models
- A metrics data source including associated metrics and a strategy map for the consolidated company, and a model for Metric extracts.
- Reports, queries, query templates, and dashboards

To run interactive reports, scripts are required. To see all the reports included in the samples packages, copy the files from the samples content installation into deployment folder and then import the deployments into the IBM Cognos Business Intelligence product.

Security
Samples are available to everyone. To implement security, see the Installation and Configuration Guide.

IBM Cognos Event Studio Samples
IBM® Cognos® Business Intelligence includes report samples and an agent sample. When installed, you can find them in the Public Folders tab in IBM® Cognos® Connection, under GO Sales (Query), in the IBM® Cognos® Event Studio Samples folder.
The Customer Contact Sample
This report sample is used in a tutorial in this document. For more information, see "Tutorial - Creating an Agent" (p. 63).

The Returns Agent Sample
This agent sample was created using the IBM® Cognos® Event Studio example illustrated in IBM® Cognos® Business Intelligence Getting Started. If you try this example yourself, you can compare the agent that you create with the Returns Agent sample.

The Returns Agent sample notifies you when a customer returns a product because it was defective, unsatisfactory, or incomplete, or because the wrong product was shipped.

The ELM Returns Agent Sample
This agent sample is used in the topic "Example - Managing the Life Cycle of an Event" (p. 24).

The ELM Returns Agent sample notifies you when a customer returns a product because it was defective, unsatisfactory, or incomplete, or because the wrong product was shipped. Two days after detecting the event, this agent checks if the issue is resolved. If unresolved event instances still exist, it runs the ELM Escalation Agent sample.

The ELM Escalation Agent Sample
This agent sample is used in the topic "Example - Managing the Life Cycle of an Event" (p. 24).

The ELM Escalation Agent sample is run by the ELM Returns Agent sample. If more than two days have lapsed since the ELM Returns Agent sample detected an event, the ELM Escalation Agent sample escalates the issue by sending an e-mail to the customer fulfillment manager.

Example - Managing the Life Cycle of an Event
Try this example to see how the ELM Returns Agent sample performs different tasks depending on the stage of the life cycle for the event.

Event Life cycle Management (ELM) is the ability to identify, track, and take appropriate action on an event at the right time and in the right sequence. Different information, people, and tasks are required at different stages in the life cycle of an event.

You are the customer fulfillment manager at the Great Outdoors company. After analyzing data warehouse metrics, you determine that when orders are returned for reasons that the Great Outdoors company can control, there is a significant impact on customer loyalty. Customers withhold payment for the entire order until the issue is resolved.

To identify these issues and resolve them as quickly as possible, you decide to run the ELM Returns Agent sample. To run this agent, do the following:

- Perform setup tasks that are necessary only to demonstrate this example. These tasks are as follows:
Configure your mail server so that IBM® Cognos® Business Intelligence can send notifications (p. 25).

Modify the agent samples to send e-mails to you (p. 25).

Simulate the occurrence of initial events (p. 26).

Simulate the passage of time and the resolution of some events (p. 28).

- Preview the output of all agent tasks (p. 27).
- Detect initial events and act on them as necessary (p. 27).
- Detect an ongoing, unresolved event and escalate the issue (p. 29).
- Confirm that the ELM Escalation Agent sample completed all its tasks successfully (p. 30)

**Example - Configure Your Mail Server**

Configure your IBM® Cognos® Business Intelligence mail server to send notifications using IBM® Cognos® Event Studio or IBM® Cognos® Connection.

**Steps**

1. Start IBM® Cognos® Configuration.
2. In the Explorer pane, click Notification.
3. Enter the notification properties:
   - In the SMTP mail server box, type a mail server that is appropriate for your environment.
   - In the Account and Password box, type your e-mail user ID and password.
   - In the Default sender box, type the following: notifications@ibmcognos
4. Save the configuration.

The next step in the "managing the life cycle of an event example" is to modify the agent samples to send e-mails to you.

**Example - Modify the Agent Samples to Send E-mails to You**

The IBM® Cognos® Event Studio agent samples named ELM Returns Agent and ELM Escalation Agent are set up to send e-mails to other people. To view the e-mails that these other people would normally receive, change the recipient e-mail address to your own e-mail address.

**Steps for the ELM Returns Agent Sample**

1. Start IBM® Cognos® Connection.
2. Click GO Sales (Query).
3. Click Event Studio Samples.
4. Click the Event Studio button on the actions toolbar next to the ELM Returns Agent sample.
   
   Event Studio starts, and the ELM Returns Agent sample appears.

5. Near the top of the window, click the Follow up required e-mail task.

6. In the Specify the email to send window, in the To box, replace salesrepresentative@yourcompany.com with your own e-mail address.

7. From the File menu, click Save.

8. From the File menu, click Exit.

   The destination address is changed to your e-mail address so that the agent sends e-mails to you. The sender address remains notifications@ibmcognos.

**Steps for the ELM Escalation Agent Sample**

1. In IBM® Cognos® Connection, click the Event Studio button on the actions toolbar next to the ELM Escalation Agent sample.
   
   Event Studio starts, and the ELM Escalation Agent sample appears.

2. Near the top of the window, click the Outstanding Returned Item Order e-mail task.

3. In the Specify the email to send window, in the To box, replace FulfilmentManager@yourcompany.com with your own e-mail address.

4. From the File menu, click Save.

5. From the File menu, click Exit.

   The destination address is changed to your e-mail address so that the agent sends e-mails to you. The sender address remains notifications@ibmcognos.

   The next step in the "managing the life cycle of an event example" is to simulate the occurrence of initial events.

**Example - Simulate the Occurrence of Initial Events**

Run part of the IBM® Cognos® Event_Studio_ELM_Agent_Modify_GoSales.sql script to simulate the following data changes:

- change the date to the current date
- change the follow-up code to -1 in four records

   A code of -1 indicates that follow-up is required.

**Steps**

1. In SQL Query Analyzer, from the File menu, click Open.

2. Go to c10_location/webcontent/samples/datasources/sqlserver and double-click the Event_Studio_ELM_Agent_Modify_GoSales.sql file.
3. In the toolbar, from the list of databases, click gosales.

4. In the Query window, under Part 1, select all sixteen lines of code.

5. From the Query menu, click Execute.

The database is updated with the changes.

The next step in the "managing the life cycle of an event example" is to preview the output of each task of an agent.

**Example - Preview the Output of Each Task of an Agent**

You can preview the output of the IBM® Cognos® Event Studio ELM Returns Agent sample based on the current data, without running the agent.

**Steps**

1. In IBM® Cognos® Connection, click the Event Studio button on the actions toolbar next to the ELM Returns Agent sample.

   Event Studio starts, and the ELM Returns Agent appears.

2. From the Actions menu, click Preview All.

   A window appears that shows the event list and the output that would be produced by each agent task. Based on this preview information, you can decide whether to run the agent.

   The next step in the "managing the life cycle of an event example" is to detect initial events and act on them.

**Example - Detect Initial Events and Act on Them**

Run the IBM® Cognos® Event Studio ELM Returns Agent to detect the initial instances of products returned for specific reasons. When these events are detected, the ELM Returns Agent does the following:

- It runs the AssignStaff stored procedure.

  AssignStaff provides details about the sales representatives associated with each event instance, including the e-mail address.

- It sends an e-mail to the appropriate sales representatives, advising them to contact their customer.

- It runs the ELM Escalation Agent.

  The ELM Escalation Agent checks for returned product events flagged by the ELM Returns Agent. If one of these events still exists after two days, the ELM Escalation Agent sends an e-mail to the customer fulfilment manager.

**Steps**

1. In IBM® Cognos® Connection, click Public Folders, then click GO Sales (query), and then click Event Studio Samples.
2. Click the run with options button on the actions toolbar next to the **ELM Returns Agent** sample.

3. Under **Time**, click **Now**.

4. Under **Prompt values**, clear the **Prompt for values** check box.

5. Click **Run**.

6. Click **OK**.

You receive two e-mails, originally intended for sales representatives Karen Bowman and Clarice Oliveira. The e-mail to Karen Bowman notifies her of one returned order. The e-mail to Clarice Oliveira notifies her of the three returned orders assigned to her, as shown in the following example.

<table>
<thead>
<tr>
<th>Order #</th>
<th>Date</th>
<th>Customer Name</th>
<th>Product</th>
<th>Return Reason</th>
<th>Contact Name</th>
<th>Telephone #</th>
</tr>
</thead>
<tbody>
<tr>
<td>7619</td>
<td>10-Feb-04, 12:00:00 AM</td>
<td>Esportes</td>
<td>Star Gazer 2</td>
<td>Defective product</td>
<td>Clarice Oliveira</td>
<td>+55 (11) 288-5032</td>
</tr>
<tr>
<td>7626</td>
<td>4-Jan-06, 12:00:00 AM</td>
<td>Esportes</td>
<td>Star Gazer 3</td>
<td>Defective product</td>
<td>Clarice Oliveira</td>
<td>+55 (11) 288-5032</td>
</tr>
<tr>
<td>7626</td>
<td>27-Jan-06, 12:00:00 AM</td>
<td>Esportes</td>
<td>Granite Shovel</td>
<td>Defective product</td>
<td>Clarice Oliveira</td>
<td>+55 (11) 288-5032</td>
</tr>
</tbody>
</table>

The task execution rules for the **ELM Returns Agent** sample specify that all tasks are performed for new events only. If you do not receive any e-mails, the agent may already have run, so that none of the detected events are new. You can reset the event list so that when the agent runs next, all detected events have a status of new.

**Tip:** From the **Actions** menu, click **Reset Event List**.

The next step in the "managing the life cycle of an event example" is to simulate the passage of time and the resolution of some events.

**Example - Simulate the Passage of Time and the Resolution of Some Events**

Run part of the IBM® Cognos® Event_Studio_ELM_Agent_Modify_GoSales.sql script to simulate data changes. First, change it so that two days elapsed since the **ELM Returns Agent** sample was last run. Second, for three of the four event instances found the last time that the **ELM Returns Agent** sample ran, change the follow-up code from -1 to +1. This indicates that only one of these event instances still requires follow-up and the other instances are resolved.

**Steps**

1. In SQL Query Analyzer, from the **File** menu, click **Open**.
2. Go to c10_location/webcontent/samples/datasources/sqlserver and double-click the Event_Studio_ELM_Agent_Modify_GoSales.sql file.

3. On the toolbar, click gosales from the list of databases.

4. In the Query window, under Part 2, select all lines of code that appear after the comments.

5. From the Query menu, click Execute.

The database is updated with the changes.

The next step in the "managing the life cycle of an event example" is to detect an ongoing unresolved event and escalate the issue.

Example - Detect an Ongoing Unresolved Event and Escalate the Issue

Run the IBM® Cognos® Event Studio ELM Returns Agent sample a second time. The agent now detects only one event because you modified the follow-up codes in the previous task (p. 28). In addition, because two days lapsed since the sales representative was notified, the event condition of the ELM Escalation Agent sample is met. The ELM Escalation Agent sample detects the event and sends an e-mail to the customer fulfilment manager.

Steps

1. In IBM® Cognos® Connection, click Public Folders, then click GO Sales (query), and then click Event Studio Samples.

2. On the actions toolbar, click the run with options button [ ] next to the ELM Returns Agent sample.


4. Under Prompt values, clear the Prompt for values check box.

5. Click Run.

6. Click OK twice.

After this agent runs, you receive only one e-mail. Instead of being sent to the sales representative, this issue is escalated to the customer fulfilment manager, as shown in the following example.

<table>
<thead>
<tr>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cc: (None)</td>
</tr>
<tr>
<td>Bcc: (None)</td>
</tr>
<tr>
<td>Subject: Outstanding Returned Item Order</td>
</tr>
</tbody>
</table>

The order 7626 is still outstanding due to unresolved return product problems. Eduardo Guimarães has been advised of order detail code 114951.

The next step in the "managing the life cycle of an event example" is to confirm that the ELM Escalation Agent sample completed its tasks successfully.
Example - Confirm that the ELM Escalation Agent Sample Completed Its Tasks Successfully

Using IBM® Cognos® Connection, you can confirm that the IBM® Cognos® Event Studio ELM Escalation Agent sample, which is run by the ELM Returns Agent sample, completed its tasks successfully.

Steps

1. In IBM® Cognos® Connection, click Public Folders, then click GO Sales (query), and then click Event Studio Samples.
2. On the actions toolbar next to the ELM Escalation Agent sample, click More.
3. Click View run history.
4. In the Actions column, click the view run history details button.

A window appears showing that the event query and e-mail task succeeded, as shown in the following example.

<table>
<thead>
<tr>
<th>View run history details - ELM Escalation Agent</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start time:</strong> April 13, 2006 4:28:46 PM</td>
</tr>
<tr>
<td><strong>Completion time:</strong> April 13, 2006 4:28:51 PM</td>
</tr>
<tr>
<td><strong>Status:</strong> Succeeded</td>
</tr>
<tr>
<td><strong>Agent:</strong></td>
</tr>
<tr>
<td><strong>Options:</strong> Unavailable</td>
</tr>
<tr>
<td><strong>Event and Tasks:</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
</tr>
</tbody>
</table>
Create an agent to monitor data for instances of an event and to perform tasks.

Before you create an agent, you should understand the notification methods that an agent can use (p. 20). You should also know how often an agent performs different types of tasks (p. 20).

To create an agent, do the following:

- Specify the event condition (p. 32).
- Add one or more of the following types of tasks for the agent to perform when the event status meets the task execution rules:
  - e-mail task (p. 34)
  - news item task (p. 35)
  - report task (p. 37)
  - job task (p. 39)
  - agent task (p. 40)
  - approval request task (p. 41)
  - notification request task (p. 45)
  - database update task (p. 47)
  - web service task (p. 47)
  - export task (p. 49)
  - import task (p. 49)
  - content maintenance task (p. 50)
  - metric task (p. 51)
  - planning macro task (p. 51)
  - migration task (p. 52)
- Specify the task execution rules (p. 52).

After you create an agent, you can:

- preview it (p. 53)
- test it (p. 59)
- run it (p. 61)
- work with it in IBM® Cognos® Connection (p. 62)
Specify an Event Condition

When you specify an event condition, you describe a specific occurrence of data items that an agent must detect before it performs its tasks. The event condition is a query expression that you create using items from the package.

For more information, see "Specify an Event Condition" (p. 66).

If you want to include parameters (p. 33) or calculations (p. 33) in the event condition, you must create them before you define the event.

Steps

1. From the Actions menu, click Specify Event Condition.

2. Create a detail expression, a summary expression, or both:
   - If you want part of the event condition to apply to values of individual source items, click the Detail tab and follow step 3.
   - If you want part of the event condition to apply to aggregate values, click the Summary tab and follow step 3.

3. In the Expression box, create a query expression:
   - Drag items from the source tab or type text directly.
   - Drag operators, summaries, and other mathematical functions from the functions tab or type text directly.
     Tip: To see the meaning of an icon on the functions tab, click the icon and read the description in the Information box.
   - If you want to insert a parameter (p. 33), drag it from the parameters tab.
   - If you want to insert a calculation (p. 33), drag it from the data items tab.
   - Insert values if required.
     Tip: To select from a list of possible values for the selected item, click the select value button. Move the values you want from the Select Value box to the Selected Items box and click OK.

   For example, you can type the following expression:
   
   \[\text{[Unit price]} \times \text{[Quantity sold]} > 5000\]

4. To check the event list to ensure that you specified the event condition correctly, from the Actions menu, click Preview.
5. To determine how many event instances there are, from the **Actions** menu, click **Count Events**.

6. From the **File** menu, click **Save As**.

7. Specify a name and location for the agent and click **OK**.

You can preview the event list returned by the event condition. For more information, see "Preview the Data" (p. 53).

**Define a Parameter**

You can define a parameter and include it in an event condition. When the agent runs, it prompts the user to enter a value for the parameter. You can also use parameters to accept the results of a previous agent.

For more information, see "Define a Parameter" (p. 64).

**Steps**

1. From the **Insert** menu, click **Parameter**.

2. In the **Parameter name** box, type a name for the parameter.

3. Click **OK**.

   The parameter appears in the **data items** tab.

You can include the parameter when you specify an event condition "Define a Parameter" (p. 64).

**Define a Calculation**

A calculation is a query expression that defines an arithmetic combination of data items. For example, you can define a calculation named Product Sales that is the product of the unit price and the quantity sold.

For more information, see "Define a Calculation" (p. 65).

**Steps**

1. From the **Insert** menu, click **Calculation**.

2. In the **Name** box, type a name for the calculation.

3. In the **Expression** box, define the calculation:

   - Drag items from the **source** tab or type text directly.

     **Tip:** If you type the text, you must include the full path of each data item. For example, you can type the following expression:

     
     
     ```
     [gosales_goretailers].[Orders].[Unit price] * [gosales_goretailers].[Orders].[Quantity]
     ```

   - Drag operators, summaries, and other mathematical functions from the **functions** tab or type text directly.
Chapter 3: Creating an Agent

Tip: To see the meaning of an icon on the functions tab, click the icon and read the description in the Information box.

- Insert values if required.
  Tip: To select from a list of possible values for the selected item, click the select value button. Move the values you want from the Select Value box to the Selected Items box and click OK.

4. Click OK.

The calculation icon appears on the data items tab.

You can include the calculation when you specify an event condition (p. 32) or specify a task.

Adding Tasks

You can add multiple tasks to an agent. However, you can specify only one event condition (p. 32) per agent. Each task is performed for the event list that meets the execution rules you specify for the task (p. 52). The agent performs tasks in the order that you add them, unless you change their order later (p. 57). You can save an agent (p. 73) and add additional tasks to it later.

Previous Function

You can add source items (p. 15) or data items (p. 15) to some types of tasks. When the agent performs the task, it uses the current value of the item. If you want the agent to use the value that a particular item had the previous time the agent ran, you can insert the previous function before the item.

To insert the previous function, from the Insert menu, click Previous Value.

Add an E-mail Task

Add an e-mail task to an agent to send an e-mail about an event to specified recipients. You can include content, such as report output, in an e-mail task.

For more information, see "Add an E-mail Task" (p. 70).

You can also add other types of tasks (p. 19). E-mail tasks share some similarities with report tasks. For more information, see "E-mail Notifications" (p. 21).

Before you add any type of task, you must specify an event condition (p. 32).

Steps

1. In the I want to area, click Add a task.

2. Click Send an email.

3. In the To box, and if applicable, in the Cc or Bcc boxes, enter the e-mail addresses of the recipients using one or more of the following methods:

- Type the addresses directly, separating each e-mail address with a semicolon.
If your model contains a data item that is an e-mail address, drag this item from the source tab or from the data items tab. When the agent runs, the current value in the package replaces the data item for each event instance.

Click Select the recipients. Select the users, groups, roles, contacts, and distribution lists. Select the entries you want, click the arrow button to update the Selected entries list, and click OK.

4. In the Subject box, type the subject of the e-mail.
   Tip: You can also drag items from the source tab or from the data items tab. When the agent runs, the current value in the package replaces the data item for each event instance.

5. In the Body box, type the e-mail message text directly or drag items from the source tab or from the data items tab.
   If you insert data items in the Body box, the body message will be longer. When the agent runs, the current value in the package replaces the data item for each event instance. For more information, see "How Multiple Events Affect E-mail Messages, Approval Requests, and Notification Requests" (p. 22).
   If the e-mail has a single HTML attachment and the Body box is empty, the attachment appears inline.

6. To change the message format from HTML to plain text or vice versa:
   • To change from the default HTML format to plain text format, click Change to plain text.
     Note: If you switch to plain text format, any HTML formatting changes are lost.
   • To change from plain text to HTML, click Change to HTML format. You can then use formatting buttons to edit the message.

7. To add attachments, click Attach and choose the attachments.

8. To add links, click Add links, select the entries you want, click the arrow button to update the Selected entries list, and click OK.

9. Under Run this email for the events, review the event status that will cause the e-mail to be sent.
   Tip: If you want to change this event status, you can edit the task execution rules (p. 58).

10. From the File menu, click Save.

You can preview the e-mail task (p. 53). When the agent runs, it retrieves values for all source and data items and sends the e-mail to the recipients you chose.

Add a News Item Task

Add a news item task to an agent to publish a headline to a folder in IBM® Cognos® Connection.

For more information, see "Add a News Item Task" (p. 72).

You can also add other types of tasks (p. 19).
Before you add any type of task, you must specify an event condition (p. 32).

**Steps**

1. In IBM® Cognos® Connection, create a new folder or portlet.
   
   For more information, see the IBM® Cognos® Connection User Guide.

2. In IBM® Cognos® Event Studio, specify an event condition (p. 32).

3. In the I want to area, click Add a task.

4. Click Publish a news item.

5. In the Headline box, type the text you want to appear at the top of your news item.
   
   Tip: You can also drag items from the source tab or the data items tab.

6. To add a description in the Screen tip box and in the Text box, type a description of the entry.
   
   The screen tip is limited to 100 characters.
   
   Tip: You can also drag items from the source tab or from the data items tab.

7. Under Link to, choose an object to appear when you click a news headline:
   
   - To link to IBM® Cognos® Business Intelligence content, click Select an entry, go to the entry, and click OK. For example, if you want the Customer Contact report to appear when someone clicks the headline, click Select an entry, locate the Customer Contact report, and click OK.
     
     Tip: You can add a report task that runs a report before the news item task is performed. If you link that report to the news item task, the report always shows information about current event instances when someone clicks the headline.
   
   - To link to a URL, type the URL address in the box.
     
     If the URL points to a web site address, include the protocol, such as http. For example, to create a URL for the IBM web site, you would type http://www.ibm.com.

8. Under News list location, click Select a location, go to the folder or portlet in which the news item will be published and click OK.

9. Under Publish this news item for the events, review the event status that will cause the news item to be published.
   
   Tip: If you want to change this event status, you can modify the task execution rules (p. 58).

10. From the File menu, click Save.

You can preview the news item task (p. 53). When the agent performs the news item task, it publishes the news headline to the location you chose. When you click the headline, the IBM® Cognos® Business Intelligence entry or the web page you linked to appears.
The description text appears when you set your IBM® Cognos® Connection preferences to use the details view. The screen tip appears when you pause your pointer over the icon for the entry in the news list location.

**Add a Report Task**

Add a report task to an agent to run a report that is related to an event.

For more information, see "Add a Report Task" (p. 67).

You can also add other types of tasks (p. 19). E-mail tasks share some similarities with report tasks. For more information, see "E-mail Notifications" (p. 21).

Before you add any type of task, you must specify an event condition (p. 32).

You must have permissions to run the report that you select. For more information, see the IBM® Cognos® Report Studio User Guide.

**Steps**

1. In the I want to area, click Add a task.

2. Click Run a report.

3. In the Select the Report dialog box, specify the report, query, analysis, or report view to include in the agent.
   - Search the folders to find the entry you want.
   - Click the entry and click OK.

4. To customize the report, under Options, click Set and make the necessary changes (p. 38).

5. If the report includes parameters, under Prompt values, choose how to specify prompt values for each parameter:
   - If you are using an item, in the Method column, click Use an item and drag an item from the source tab or from the data items tab to the Value column.
     
     **Tip:** When you specify a data item, values from the event list are passed as prompt values in the report. If the event list has multiple instances, then multiple values are passed as prompt values. Therefore, you must ensure that the report being run has a prompt that can accept multiple values. For more information, see the IBM® Cognos® Report Studio User Guide.
   - If you are using a value, in the Method column, click Use a value, click Specify values, and in the Value column, type a value.
     
     **Tip:** If you want to clear the prompt values and return to the default values, click Reset to default.

6. Under Run this report for the events, review the event status that will cause the report to run.
   
   **Tip:** If you want to change this event status, you can modify the task execution rules (p. 58).

7. From the File menu, click Save.
You can preview the report task (p. 53). When the agent performs the report task, it runs the report and delivers it according to the delivery options you chose (p. 38).

**Customize the Report**

You can change the report options from the default options to customize the report for your audience:

- Change one or more report output formats.
- Change one or more languages.
- Change one or more delivery methods.
- Burst the report if it was authored with bursting specifications.

Default options are set by the report author. You can change some default run options for reports. You change the report options when you click Set or Edit in the Specify the report to run dialog box. For more information, see "Add a Report Task" (p. 37).

Setting the report options for a report task in IBM® Cognos® Event Studio is similar to running a report with options in IBM® Cognos® Connection. For more information, see the IBM® Cognos® Connection User Guide.

**Steps**

1. In the Select the report options dialog box, select the Override the default values check box.
2. Under Formats, click the formats you want for the report output.
3. To select different or additional languages for the report, click Select the languages and use the arrow keys to move the available languages to the Selected languages box and click OK.
   Tip: To select multiple languages, press Ctrl+click or Shift+click.
4. Under Delivery, choose a delivery method:
   - To save the report, select the Save check box, then click the button next to Save the report.
   - To save the report as a report view, select the Save check box, then click the button next to Save the report as a report view. You can change the name or target folder of the report view by clicking Edit the options. Make the changes, and click OK.
     Tip: Save the report as a report view if you do not have write access to the report. You can then add a link to the report view when you specify an e-mail task.
   - To print the report, select the Print the report check box and click Select a printer. Click the button next to the printer you want to use and click OK. Or, if the printer is not listed, you can type the printer information.
     Tip: If you have administrator privileges and want to set up the printer for future use, click New printer. You must type the network address of the printer by using the format `<server_name>\printer_name` for a network printer on a Windows® operating system installation and `printer_name` for a UNIX® operating system installation or for a local printer.
   - To e-mail the report, select the Send the report by email check box.
5. If you clicked **Send the report by email**, click **Edit the options** to specify what you want:
   - To send the e-mail to IBM® Cognos® Business Intelligence recipients, click **Select the recipients**. Select the check box next to the names you want to include, and click **To**, **Cc** (copy), or **Bcc** (blind copy). The entries that you select are listed under **Selected entries**. Click **OK**.
   - **Tip:** To select all entries in a list, click the check box in the upper-left corner of the list. To remove names from **Selected entries**, select the check box next to the name and click **Remove**.
   - To search, click **Search**. In the **Search string** box, type the phrase you want to search for. For advanced search features, click **Advanced**.
   - If you want to send the e-mail to other recipients, in the **To:**, **Cc**, or **Bcc** boxes, type the e-mail addresses separated by semicolons (;).
   - **Tip:** If you logged on, your name automatically appears in the **To** list box.
   - Under **Subject**, type the subject of the e-mail.
   - Under **Body**, type a message to be included in the e-mail.
   - If you want to include an attachment, select the check box to include the report or a link to the report, and click **OK**.
   - If you are an administrator, you can prevent users from including attachments. For more information, see the IBM® Cognos® Administration and Security Guide.

6. Under **Bursting**, specify whether the report should be bursted.
   - This option is available only if the report author defined burst keys in the report.

7. Click **OK**.
   - The **Specify the report to run** dialog box appears.

8. Continue specifying the report. For more information, see "Add a Report Task" (p. 37).

### Add a Job Task

Add a job task to an agent to run a job. A job identifies a collection of reports, report views, agents, and other jobs that are scheduled together and share the same schedule settings. For more information, see the IBM® Cognos® Connection User Guide.

For example, in IBM® Cognos® Connection, you create a job named Two Reports, and select two reports that you want the job to run. In IBM® Cognos® Event Studio, you add a job task and select the Two Reports job. When the agent runs and detects events that meet the task execution rules, it runs the Two Reports job.

You can also add other types of tasks (p. 19).

Before you add any type of task, you must specify an event condition (p. 32).
Before you create a job task, you must create a job in IBM® Cognos® Connection. For more information, see the IBM® Cognos® Connection User Guide.

**Steps**

1. In the **I want to** area, click **Add a task**.
2. Click **Run a job**.
3. In the **Select the job** dialog box, specify the job to include in the agent.
   - Search the folders to find the job you want.
   - Click the entry and click **OK**.
4. Under **Run this job for the events**, review the event status that will cause the job to run.
   **Tip:** If you want to change this event status, you can modify the task execution rules (p. 58).
5. From the **File** menu, click **Save**.

You can preview the job task (p. 53). When the agent performs the job task, it runs all the IBM® Cognos® Business Intelligence items identified in the job.

**Add an Agent Task**

Add an agent task to an agent to run another agent. By running multiple agents in sequence, you can use the output from one agent as the input to another agent. You can also use multiple agents that interact with each other using data retrieved from different data sources. This removes the need to join databases using IBM® Cognos® Framework Manager.

For more information, see "Example - Adding an Agent Task" (p. 41).

You can also add other types of tasks (p. 19).

Before you add any type of task, you must specify an event condition (p. 32).

**Steps**

1. In the **I want to** area, click **Add a task**.
2. Click **Run an agent**.
3. In the **Select the agent** dialog box, choose an agent.
   - Search the folders to find the agent you want.
   - Click the entry and click **OK**.
4. If the task includes parameters, under **Prompt values**, choose how to specify prompt values for each parameter:
   - If you are using a value, in the **Method** column, click **Use a value**, click **Specify values**, and in the **Value** column, type a value.
• If you are using an item, in the Method column, click Use an item and drag an item from the source tab or from the data items tab to the Value column.

Tip: If you want to clear the prompt values and return to the default values, click Reset to default.

5. Under Run this agent for the events, review the event status that will cause the agent to be run.

Tip: If you want to change this event status, you can modify the task execution rules (p. 58).

6. From the File menu, click Save.

You can preview the agent task (p. 53). When the agent performs the agent task, it runs the agent you specified.

Example - Adding an Agent Task

You want to run the high_returns_followup agent to detect a high rate of returned items and resolve the related issue. However, for each item that has a high rate of return, you also want to check the importance of the customer to your company as calculated from data in a data warehouse system. The customer’s importance value is calculated using projected sales and profit data.

You create a second agent named high_returns_customer_check that is run by the high_returns_followup agent. When a high return event occurs, the high_returns_followup agent runs and passes customer details to the high_returns_customer_check agent. The high_returns_customer_check agent then runs a query to check the customer importance value. If the customer importance value is high, the high_returns_customer_check agent sends an e-mail asking the customer services agent to contact the customer and fix the problem immediately.

Add an Approval Request Task

Add an approval request task to an agent when you want an event to occur only after approval. This task sends an approval request related to an event to the task inbox of specified recipients in IBM® Cognos® Business Intelligence.

A recipient can be a potential owner or a stakeholder. Multiple users, groups, roles, and distribution lists can be assigned as potential owners of an approval request task. Stakeholders can be users, groups, roles, and distribution lists that are identified as interested parties, but are not potential owners.

Tip: To track the progress of an approval request task that you create, you can add yourself as a stakeholder.

For more information on the task inbox, see the IBM® Cognos® Connection User Guide.

You can include content, such as report output, in an approval request.

You can set up approval requests with different actions:

• Approve/Reject the request

  The task owner must approve or reject the request from their task inbox to complete the task. If you schedule further agent tasks to run after the approval request task, these are dependent on approval by the task owner. If the request is rejected, no further agent tasks will run.
Chapter 3: Creating an Agent

- Specify which of the remaining tasks to run

When you schedule further agent tasks to run after the approval request, the task owner must select which of those tasks to run on completion of the approval request.

You can add start date and due date deadlines to an approval request when you create the task in IBM® Cognos® Event Studio. Alternatively, potential owners or stakeholders can add deadlines at a later date by updating the approval request from their task inbox.

You can set up notification options for e-mails to be sent to

- all potential owners when an approval request is created
- the task owner when an approval request is not completed by the due date
- the task owner when an approval request is not started by the start date

Note: Stakeholders are also copied on e-mails.

In addition, you can set up notification options for the task owner and all stakeholders to receive e-mails when

- the status of an approval request changes (started, completed or canceled)
- the owner of an approval request changes
- a comment is added to an approval request

Note: Potential owners and stakeholders can unsubscribe from receiving specific notifications by updating the approval request from their task inbox.

Customized icons

You can add customized icons, using your own graphic files, to approval requests that appear in a recipient’s task inbox.

To add a customized icon, use one of the following methods:

- Type the explicit location and name for the graphic file.
- Insert an item from the Insertable Items pane that contains a value for the relative path and name for the graphic file.

Files to support custom icons must be located within the c10_location\webcontent directory and a copy of the files must exist on all IBM® Cognos® Business Intelligence gateway server installs.

For example, to use the file green.jpg, where IBM® Cognos® Business Intelligence is installed in c:\program files\IBM\cognos\c10\green.jpg must exist within a path contained within c:\program files\IBM\cognos\c10\webcontent\samples\images\green.jpg must exist within a path contained within c:\program files\IBM\cognos\c10\webcontent\samples\images\green.jpg

When you configure a task to use green.jpg (located in c:\program files\IBM\cognos\c10\webcontent\samples\images\green.jpg) as a customized icon, the value you enter in the icon Item box is either

- ./samples/images/green.jpg (explicit location)
- or, an item from the insertable items pane which contains the value ./samples/images/green.jpg (relative location)
You can also add other types of tasks (p. 19).

Before you add any type of task, you must specify an event condition (p. 32).

**Steps**

1. In the I want to area, click Add a task.

2. Click Run an approval request.

3. In the Potential owners box, and if applicable, in the Stakeholders box, enter the names of the recipients by using one or more of the following methods:
   - If your model contains a data item that is a user, group, role or distribution list, drag this item from the source tab or from the data items tab. When the agent runs, the current value in the package replaces the data item for each event instance.
   - Click Select the recipients to select the users, groups, roles or distribution lists.
     To choose from listed entries, click the appropriate namespace, and then select the required check boxes.
     **Tip:** To make the user entries visible, click Show users in the list.
     To search for entries, click Search and in the Search string box, type the phrase you want to search for. For search options, click Edit. Find and click the entry you want.
     Click the Potential Owner or Stakeholder arrow button to update the Selected entries list, and click OK.
     **Tip:** To remove entries from the Selected entries list, select them and click Remove. To select all entries in a list, click the check box in the upper-left corner of the list.
     Click OK.
     **Note:** You must add at least one stakeholder. By default, you are added as a stakeholder when you create the approval request.

4. In the Subject box, type the subject of the approval request.
   **Tip:** You can also drag items from the source tab or from the data items tab. When the agent runs, the current value in the package replaces the data item for each event instance.

5. In the Body box, type text directly or drag items from the source tab or from the data items tab.
   If you insert data items, the body message will be longer. When the agent runs, the current value in the package replaces the data item for each event instance. For more information, see "How Multiple Events Affect E-mail Messages, Approval Requests, and Notification Requests" (p. 22).

6. To change the message format:
   - Click Change to plain text to change from the default HTML format to plain text format.
     **Note:** If you switch to plain text format, any HTML formatting changes are lost.
Chapter 3: Creating an Agent

- Click **Change to HTML format** to change from plain text to HTML. You can then use formatting buttons to edit the message.

7. To add attachments, click **Attach** and choose the attachments.

8. To add links, click **Add links**, select the entries you want, click the arrow button to update the **Selected entries** list, and click **OK**.

9. Select the following due date options if required:
   - **Start within** to add a start by deadline, and then type the number of days in the **Days** box.
   - **Due within** to add a due date deadline, and then type the number of days in the **Days** box.

10. To add a customized icon to the approval request in the task inbox, drag an item from the **source** tab or from the **data items** tab into the icon **Item** box.

   **Tip:** To revert to using the default task icon, select the **Default** icon option.

11. To change the priority of the approval request, select a predefined option from the **Priority** list or drag an item from the **source** tab or from the **data items** tab into the priority **Item** box.

12. Select the action required by the task owner to complete the task:
   - **Approve/Reject the running of all remaining tasks** (default)
     By default, the approval request contains **Approve** and **Reject** action buttons. To change the default button names, click **Customize**, type the required names, and then click **OK**.
   - **Specify which of the remaining tasks to run**
     Select the tasks to include in the approval request.

     **Note:** Only agent tasks that are scheduled to run after the approval request are listed here.
     By default, the approval request contains a **Submit** action button. To change the default button name, click **Customize**, and type the required button name. When you have finished, click **OK**.

     **Tip:** You can also change the names of the agent tasks as they appear in the task inbox. For example, you could append the task type to the agent task name.

13. Select the approval request creation and deadline notification options as required:
   - **Send notification upon creation** (default)
   - **Send notification if not started by start by date**
   - **Send notification if not completed by due date**

14. Select the approval request change notification options as required:
   - **Started**
   - **Comment**
   - **Owner changed**
15. From the File menu, click Save.

You can preview the approval request task (p. 53). When the agent runs, it retrieves values for all source and data items and sends the approval request to the recipients you chose.

**Add a Notification Request Task**

Add a notification request task to an agent to send a secure notification about an event to the inbox of specified recipients in IBM® Cognos® Business Intelligence.

**Tip:** To track the progress of a notification request task that you create, you can add yourself as a copied recipient (stakeholder).

You can include content, such as report output, in a notification request.

For more information on the task inbox, see the IBM® Cognos® Connection User Guide.

You can set up a notification option that requires recipients to acknowledge a notification request in their task inbox. You can also set up notification options for recipients to receive e-mails when

- a notification request is created
- a notification request has not been acknowledged within a specified time

You can also add other types of tasks (p. 19).

Before you add any type of task, you must specify an event condition (p. 32).

**Steps**

1. In the I want to area, click Add a task.
2. Click Run a notification request.
3. In the To box, and if applicable, in the Cc box, enter the names of the recipients by using one or more of the following methods:
   - If your model contains a data item that is a user, role or group, drag this item from the source tab or from the data items tab. When the agent runs, the current value in the package replaces the data item for each event instance.
   - Click Select the recipients to select the users, groups, roles or distribution lists.
     To choose from listed entries, click the appropriate namespace, and then select the required check boxes.
     **Tip:** To make the user entries visible, click Show users in the list.
     To search for entries, click Search and in the Search string box, type the phrase you want to search for. For search options, click Edit. Find and click the entry you want.
     Click the To or Cc arrow button to update the Selected entries list, and click OK.
Tip: To remove entries from the Selected entries list, select them and click Remove. To select all entries in a list, click the check box in the upper-left corner of the list.

Click OK.

4. In the Subject box, type the subject of the notification request.

Tip: You can also drag items from the source tab or from the data items tab. When the agent runs, the current value in the package replaces the data item for each event instance.

5. In the Body box, type text directly or drag items from the source tab or from the data items tab.

If you insert data items, the body message will be longer. When the agent runs, the current value in the package replaces the data item for each event instance. For more information, see "How Multiple Events Affect E-mail Messages, Approval Requests, and Notification Requests" (p. 22).

If the notification request has a single HTML attachment and the Body box is empty, the attachment appears inline.

6. To change the message format:
   - Click Change to plain text to change from the default HTML format to plain text format.
     Note: If you switch to plain text format, any HTML formatting changes are lost.
   - Click Change to HTML format to change from plain text to HTML. You can then use formatting buttons to edit the message.

7. To add attachments, click Attach and choose the attachments.

8. To add links, click Add links, select the entries you want, click the arrow button to update the Selected entries list, and click OK.

9. To change the priority, select a predefined option from the Priority list or drag an item from the source tab or from the data items tab into the Item box.

10. Select the notification request notification options as required:
   - Send notification by email upon creation
   - Request acknowledgement
   - Send notification if not acknowledged within
     Type the specified number of days in the Days box.

11. From the File menu, click Save.

You can preview the notification request task (p. 53). When the agent runs, it retrieves values for all source and data items and sends the notification request to the recipients you chose.
Add a Database Update Task

Add a database update task to an agent to run stored procedures that exist in a database. A stored procedure takes arguments as input and updates the database. The database that contains the stored procedures can be different from the database in the package that the agent is monitoring.

For information about running stored procedures, see the IBM® Cognos® Administration and Security Guide.

You can also add other types of tasks (p. 19).

A stored procedure is accessible in IBM® Cognos® Event Studio only if it was marked as a data modification type in IBM® Cognos® Framework Manager. If the input parameters to the stored procedure task are unavailable, check how your procedure has been modelled. For more information, see the IBM® Cognos® Framework Manager User Guide.

Before you add any type of task, you must specify an event condition (p. 32).

Steps
1. In the I want to area, click Add a task.
2. Click Update a database.
3. Under Package, select the package to use to update the database.
4. Under Data modification stored procedure, select a stored procedure that exists for the package you selected.
5. If the stored procedure includes arguments, under Arguments, choose how to specify values for each argument:
   - If you are using a value, in the Method column, click Use a value, click Specify values, and in the Value column, type a value.
   - If you are using an item, in the Method column, click Use an item and drag an item from the source tab or from the data items tab to the Value column.

Tip: To clear the argument values and return to the default values, click Reset to default.
6. Under Update the database for the events, review the event status that will cause the stored procedures to run.

   Tip: If you want to change this event status, you can modify the task execution rules (p. 58).
7. From the File menu, click Save.

You can preview the database update task (p. 53). When the agent performs the database update task, the stored procedures are run and the database is updated.

Add a Web Service Task

Use a web service task to trigger an external process. Web services let software programs interact with one another using standard Internet protocols, so interaction is not dependant on operating
system or program language compatibility. Web services also work well in a distributed environment because they use URLs to reference programs.

You can also add other types of tasks (p. 19).

Before you add any type of task, you must specify an event condition (p. 32).

When you specify the web service URL, IBM® Cognos® Event Studio calls a web server and requests the Web Services Description Language (WSDL). This shows you the web service input and output parameters.

Note: Before you can run a web service task in Event Studio, you must follow additional preparation steps. For more information, see "Preparing to Run a Web Service Task" (p. 59).

Steps
1. In the I want to area, click Add a task.
2. Click Advanced.
3. Click Call a Web service.
4. In the Web service URL box, type the URL of the web service.
   If the URL points to a web site address, you must include the protocol, such as http.
5. Click Retrieve.
   The available web service operations are retrieved.
6. Under Operation, click the web service operation you want to perform.
   The available method and the list of arguments is retrieved.
7. If the operation includes arguments, under Arguments, choose how to specify values for each argument:
   • If you are using a value, in the Method column, click Use a value, click Specify values, and in the Value column, type a value.
   • If you are using an item, in the Method column, click Use an item and drag an item from the source tab or from the data items tab to the Value column.
   Tip: To clear the argument values and return to the default values, click Reset to default.
8. Under Call the Web service for the events, review the event status that calls the web service.
   Tip: If you want to change this event status, you can modify the task execution rules (p. 58).
9. From the File menu, click Save.

You can preview the web service task (p. 53). When the agent performs the web service task, it calls the web service and runs its service.

Example - Adding a Web Service Task

You want to notify customer service representatives and suppliers about orders that have a high rate of return. You could do this by adding an e-mail task. For more information, see "Add an E-
However, you know that some of the service representatives and suppliers do not have access to e-mail. You also know that they all closely monitor the Customer Relationship Management (CRM) system.

You decide to notify the service representatives and suppliers by creating records in the CRM system. Each record is linked to a customer name and to the type of product that was returned. Your company developed a web service that creates CRM records. In IBM® Cognos® Event Studio, you add a web service task that calls your company’s web service.

When the agent performs the web service task, the web service updates the profile of customers who returned products. An updated customer profile can improve your sales performance in two ways:

- It helps the services representative contact the customer quickly to resolve the current problem.
- It helps the supplier ensure that they don’t make the mistake of supplying a particular product to that customer again.

Add an Export Task

Add an export task to an agent to export entries to a deployment archive. The export is defined in IBM® Cognos® Connection. For more information, see the IBM® Cognos® Administration and Security Guide.

You can also add other types of tasks (p. 19).

Before you add any type of task, you must specify an event condition (p. 32).

Steps

1. In the I want to area, click Add a task.
2. Click Run an export.
3. Click Select the export, and specify the export to include in the agent.
   - Search the folders to find the export you want.
   - Click the entry and click OK.
4. Under Run the export for the events, review the event status that runs the export.
   Tip: If you want to change this event status, you can modify the task execution rules (p. 58).
5. From the File menu, click Save.

You can preview the export task (p. 53).

Add an Import Task

Add an import task to an agent to import entries from a deployment archive to your target environment. The import is defined in IBM® Cognos® Connection. For more information, see the IBM® Cognos® Administration and Security Guide.

You can also add other types of tasks (p. 19).
Before you add any type of task, you must specify an event condition (p. 32).

**Steps**

1. In the *I want to* area, click **Add a task**.
2. Click **Run an import**.
3. Click **Select the import** and specify the import to include in the agent.
   - Search the folders to find the import you want.
   - Click the entry and click **OK**.
4. Under **Run the import for the events**, review the event status that will run the import.
   **Tip:** To change this event status, you can modify the task execution rules (p. 58).
5. From the **File** menu, click **Save**.

You can preview the import task (p. 53).

**Add a Content Maintenance Task**

Add a content maintenance task to an agent to run a content maintenance task created in IBM® Cognos® Connection. A content maintenance task searches the content store for user information that no longer exists in your external namespaces. It can also fix the content store by deleting any users that do not exist in your external namespaces. For more information, see the IBM® Cognos® Administration and Security Guide.

You can also add other types of tasks (p. 19).

Before you add any type of task, you must specify an event condition (p. 32).

**Steps**

1. In the *I want to* area, click **Add a task**.
2. Click **Run a content maintenance task**.
3. Click **Select the content maintenance task** and specify the content maintenance task to include in the agent.
   - Search the folders to find the content maintenance task you want.
   - Click the entry and click **OK**.
4. Under **Run the content maintenance task for the events**, review the event status that runs the content maintenance task.
   **Tip:** To change this event status, you can modify the task execution rules (p. 58).
5. Under **Mode**, choose whether to find or find and fix problems:
   - To find user information that no longer exists in your external namespaces, click **Find only**.
• To find and delete from the content store any users that do not exist in your external namespaces, click **Find and fix**.

6. From the **File** menu, click **Save**.

You can preview the content maintenance task (p. 53).

## Add a Metric Task

Add a metric task to an agent to run tasks that are available in a metric package. For example, you can clear metric history data from the data store or you can import data from files into a staging area. For more information, see the *IBM® Cognos® Metric Studio User Guide*.

You can also add other types of tasks (p. 19).

Before you can open a metric package, you must install IBM® Cognos® Metrics Manager. For more information, see the *IBM® Cognos® Metrics Manager Quick Start Installation and Configuration Guide*. Before you add any type of task, you must specify an event condition (p. 32).

### Steps

1. In the **I want to** area, click **Add a task**.

2. Click **Metric Task**.

3. Click **Select the metric task** and specify the metric task to include in the agent.
   - Search the folders to find the metric task you want.
   - Click the entry and click **OK**.

4. Under **Run the metric task for the events**, review the event status that runs the metric task.
   - Tip: To change this event status, you can modify the task execution rules (p. 58).

5. From the **File** menu, click **Save**.

You can preview the metric task (p. 53).

## Add a Planning Macro Task

Add a planning macro task to an agent to run Contributor macros when specified conditions are met. A planning macro is created in IBM® Cognos® Planning Contributor to automate tasks such as loading import data and publishing data. For more information about planning macros, see the *IBM® Cognos® Planning Contributor Administration Guide*.

You can also add other types of tasks (p. 19).

Before you add any type of task, you must specify an event condition (p. 32).

### Steps

1. In the **I want to** area, click **Add a task**.

2. Click **Advanced**.
Chapter 3: Creating an Agent

3. Click **Run a planning macro task**.

4. Click **Select the planning macro** and specify the task to include in the agent.
   - Search the folders to find the task you want.
   - Click the entry and click **OK**.

5. Under **Run the planning macro task for the events**, review the event status that runs the task.
   **Tip:** If you want to change this event status, you can modify the task execution rules (p. 58).

6. From the **File** menu, click **Save**.
You can preview the task (p. 53).

**Add a Migration Task**

Add a migration task to an agent to migrate IBM® Cognos® Series 7 PowerPlay® content to IBM® Cognos® PowerPlay®. The migration task must be defined in IBM® Cognos® Administration.

For more information on defining a migration task, see the IBM® Cognos® PowerPlay® Migration and Administration Guide.

You can also add other types of tasks (p. 19).

**Steps**

1. In the **I want to** area, click **Add a task**.

2. Click **Advanced**.

3. Click **Run a migration task**.

4. Click **Select the migration task** and specify the task to include in the agent.
   - Search the folders to find the task you want.
   - Click the entry and click **OK**.

5. Under **Run the migration task for the events**, review the event status that runs the task.
   **Tip:** If you want to change this event status, you can modify the task execution rules (p. 58).

6. From the **File** menu, click **Save**.
You can preview the task (p. 53).

**Specify the Task Execution Rules**

Task execution rules specify when a task is performed. By default, a task is performed for new instances of events and all ongoing instances of events, but you can change this.
For more information, see "Change the Task Execution Rules for a Report Task" (p. 68) or "Change the Task Execution Rules for an E-mail Task" (p. 71).

You specify the task execution rules separately for each task in the agent.

Before you specify the task execution rules, you must add one or more tasks (p. 34).

**Steps**

1. In the I want to area, click **Manage the task execution rules**.

2. On the **Event Key** tab, click one of the following:
   - **Include all items** (default)
   - **Include only selected items**, then on the **source** tab, click one or more data items that uniquely define an event and drag it to the box.
     
     For example, click **Order Number**, because no two event instances can have the same order number.

     The event key is defined for all tasks in the agent.

3. Click the **Event Selection** tab.

4. In the **Task** box, click the task that the agent will perform for the event statuses you specify.

5. Under **Select when to perform each task** page, click one of the following:
   - **For selected events**, and select one or more event status values.
   - **When the agent or any of its tasks fail**.

6. Click **OK**.

   The execution rules for each task you selected are set.

   **Tip:** If you want to reset the execution rules for every task in the agent to the default values, from the **Actions** menu, click **Remove Task Execution Rules**. Each task is reset to be performed for new instances of events and all ongoing instances of events.

7. Save the agent.

**Preview the Data**

You can see the list of events detected when the event definition is applied to the current data. You can also see preview information about each task in your agent.

For example, you are an administrator and want to preview the event list and all the tasks before you make the agent available for other people to use.

The preview information for each type of agent item is described in the following table.
<table>
<thead>
<tr>
<th>Agent item</th>
<th>Preview information</th>
</tr>
</thead>
<tbody>
<tr>
<td>The event list</td>
<td>A table appears with columns for each data item contained in the event condition. For each event instance, a row appears that shows the value of each data item.</td>
</tr>
<tr>
<td>e-mail task</td>
<td>Representations appear of all e-mails that would be sent using the default task execution rules. Data items in the recipient, subject, and body fields are replaced by values from the source data.</td>
</tr>
<tr>
<td>News item task</td>
<td>A representation appears of the news item that would be created using the default task execution rules. Data items in the recipient, subject, and body fields are replaced by values from the source data.</td>
</tr>
</tbody>
</table>
| Report task             | If the report accepts prompt values, a table appears with columns for each parameter. For each event instance, a row appears that contains the prompt values.  
                          | If the report does not accept prompt values, a sentence appears telling you that the report will run once.                                             |
| Job task                | A sentence appears telling you that the task will run once.                                                                                          |
| Agent task              | If the agent accepts prompt values, a table appears with columns for each parameter. For each event instance, a row appears that contains the prompt values.  
                          | If the agent does not accept prompt values, a sentence appears telling you that the agent will run once.                                               |
| Approval request task   | A representation appears of the approval request that would be created using the default task execution rules. Data items in the recipient, subject, and body fields are replaced by values from the source data.  
                          | In addition, a table appears indicating the approval request deadlines, priority, and action button names.                                            |
| Notification request task | A representation appears of the notification request that would be created using the default task execution rules. Data items in the recipient, subject, and body fields are replaced by values from the source data.  
<pre><code>                      | In addition, a table appears indicating the priority and notification request options.                                                               |
</code></pre>
<table>
<thead>
<tr>
<th>Agent item</th>
<th>Preview information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database update task</td>
<td>If the stored procedure accepts arguments, a table appears with columns for each argument. For each event instance, a row appears that contains the argument values. If the stored procedure does not accept arguments, a sentence appears telling you that the stored procedure will run once.</td>
</tr>
<tr>
<td>Web service task</td>
<td>If the web service accepts arguments, a table appears with columns for each argument. For each event instance, a row appears that contains the argument values. If the web service does not accept arguments, a sentence appears telling you that the web service will run once.</td>
</tr>
<tr>
<td>Export task</td>
<td>A sentence appears telling you that the task will run once.</td>
</tr>
<tr>
<td>Import task</td>
<td>A sentence appears telling you that the task will run once.</td>
</tr>
<tr>
<td>Content maintenance task</td>
<td>A sentence appears telling you that the task will run once.</td>
</tr>
<tr>
<td>Metric task</td>
<td>A sentence appears telling you that the task will run once.</td>
</tr>
<tr>
<td>Planning macro task</td>
<td>A sentence appears telling you that the task will run once.</td>
</tr>
<tr>
<td>Migration task</td>
<td>A sentence appears telling you that the task will run once.</td>
</tr>
</tbody>
</table>

Items shown on the preview pages show data for every event instance in the event list. If you change the task execution rules, the preview data remains the same. For more information, see "Specify the Task Execution Rules" (p. 52).

Before you can preview data, you must define an event condition (p. 32).

**Step**

- From the **Actions** menu, click **Preview All** or **Preview**.

The **Preview All** report begins with a table of contents that contains links to the preview information for each agent item. The **Preview** report shows preview information for the agent item on the current page.

### Create a Schedule for an Agent

By scheduling an agent to run at regular intervals, you do not have to manually run the agent. The agent monitors data and performs tasks to ensure that problems are dealt with as soon as possible.
You use IBM® Cognos® Connection to schedule an agent the same way that you schedule other IBM® Cognos® Business Intelligence items. For more information, see the IBM® Cognos® Connection User Guide.

Only one schedule can be associated with each agent. If you require multiple schedules for an agent, create agent views and then create a schedule for each view.

**Steps**
1. In the I want to area, click **Schedule the agent**.
2. Under **Frequency**, select how often you want the schedule to run.
3. Under **Start**, select the date and time when you want the schedule to start.
4. Under **End**, select when you want the schedule to end.
   
   **Tip:** If you want to create the schedule but not apply it right away, select the **Disable the schedule** check box. To later enable the schedule, clear the check box.
5. If you want to override the default values that you defined for the agent (p. 56), under **Prompt values**, select the check box.
6. Click **OK**.

**Specify Default Options for an Agent**
Specify default options for an agent when you want every task in the agent to use the same values for

- report task options (p. 38)
- content maintenance options (p. 50)

**Steps**
1. From the **Actions** menu, click **Set Default Options for All Tasks**.
2. Specify the default options you want.
3. From the **File** menu, click **Save**.

In IBM® Cognos® Connection, you can change the defaults that are set for agents in IBM® Cognos® Event Studio, such as whether to use prompt values and run the agent as owner. For more information, see the IBM® Cognos® Connection User Guide.

**Allow Users to Subscribe to the Alert List of the Agent**
You can specify that you want IBM® Cognos® Connection users to be able to add their e-mail addresses to the agent alert list.

When the agent runs, the alert list is added to the Bcc box in all e-mails sent using e-mail tasks or report tasks.
For information about how to add your name to an alert list, see the IBM® Cognos® Connection User Guide.

**Steps**

1. From the Actions menu, click Manage Alert List.
2. Select the Allow users to add themselves to the alert list check box.
   
   **Tip:** If you want to remove everyone from the alert list, click Remove all.
3. From the File menu, click Save.

---

### Change the Order in Which to Run Tasks

You can change the order in which to run tasks. By default, all tasks run at the same time. These are called parallel tasks. If some tasks require a significant amount of processing time, parallel tasks can save time.

You can also specify that one task finishes before the next task begins, and so on.

For example, an agent runs a report task that saves a prompted report. Next, the agent runs an e-mail task and attaches the saved report. For more information, see "Tutorial - Creating an Agent" (p. 63).

**Note:** If your agent contains any of the following tasks, and the task includes a saved report from a report task, you must order the tasks in a particular way:

- e-mail task
- approval request task
- notification request task

You must order the e-mail task or request task after the report task. If you do not order the tasks in this way, the saved report output or report link will be missing from the e-mail or request that is created.

**Steps**

1. In the I want to area, click Reorder the tasks.
2. Choose whether to specify the order or run all tasks at the same time:
   
   - To run the tasks in a specific order, click In sequence and, in the Tasks box, click tasks and change their order by clicking Up or Down.
   
   - To run all the tasks in parallel, click All at once.
3. Click OK.
4. From the File menu, click Save.
Modify an Event Condition

Modify an event condition when you want to change the data instances that prompt the agent to perform its tasks.

Steps
1. In IBM® Cognos® Connection, click the edit agent button for the agent you want to modify.
2. In the summary area, click the Event tab.
3. Change the values as required. For more information about the values required for an event condition, see "Specify an Event Condition" (p. 32).
4. From the File menu, click Save.

Modify or Delete a Task

Modify or delete a task when you want to make changes to any of the tasks in the agent.

If you want to add a task, in the I want to area, click Add a task, and click a task type. For more information, see "Adding Tasks" (p. 34).

Steps
1. In IBM® Cognos® Connection, click the edit agent button for the agent you want to modify.
2. If you want to modify a task, do the following:
   - In the summary area, under Tasks, click the tab for the task you want.
   - Change the values as required. For more information about the values required for each type of task, see "Adding Tasks" (p. 34).
3. If you want to delete a task, do the following:
   - In the summary area, under Tasks, click the tab for the task you want to delete.
   - From the Edit menu, click Delete.
4. Save the agent.

Modify the Task Execution Rules

Modify the task execution rules when you want to change the list of event instances for which a task is performed.

Steps
1. In IBM® Cognos® Connection, click the edit agent button for the agent you want to modify.
2. In the I want to area, click Manage the task execution rules.
3. Change the values as required. For more information, see "Specify the Task Execution Rules" (p. 52).

4. If you want to reset the task execution rules to the default values, from the Actions menu, click Remove Task Execution Rules.
   The task is performed for new instances of events and all ongoing instances of events.

5. From the File menu, click Save.

Test an Agent

Before you run an agent, you can test whether the following conditions are met to increase the chance that the agent runs successfully:

- The event condition is a valid query expression.
- All parameters are satisfied correctly.
- All referenced data items exist.

Steps

1. From the Actions menu, click Validate.
   The View the validation results dialog box appears.

2. If an error message appears, fix the error and then repeat steps 1 to 2.
   If an error message appears when you run the agent, write down the error message and troubleshoot the problem.
   For more information, see the Troubleshooting section of the IBM® Cognos® Administration and Security Guide.

3. When the No Errors message appears, click OK.
   The agent is now ready to run (p. 61).

Preparing to Run a Web Service Task

Before you can run a web service task in IBM® Cognos® Event Studio, you must

- generate the required Java™ object (.jar) file for the web service
- register the domain name for the web service

Generating a Java Object File

By default, Java™ object (.jar) files are stored in the folder c10_location\webapps\p2pd\WEB-INF\lib\es_ws_objs

If you are an administrator, you can change this folder using IBM® Cognos® Configuration.
To generate .jar files, you must be running Java™ Development Kit (JDK) with a Java™ compiler (javac.exe).

**Note:** If you are running multiple web services, you must generate a separate .jar file for each one. Because each generated file has the same file name, you must rename each .jar file before generating the next one.

### Steps to Generate the Java Object File

1. Using an editor, open the file `c10_location\bin\es_build_ws_objs.bat`
2. Modify the JAVA_HOME environment variable to point a JDK location.
3. Run the following command:
   - On a Windows® operating system, type `cognos10\bin>es_build_ws_objs <web_service_URL>`
     For example, `c10_location\bin>es_build_ws_objs http://wtwincqclab7/ws6/service.asmx?wsdl`
   - On a UNIX® operating system, type `es_build_ws_objs.sh`
     This generates a file named es_ws_objs.jar in the specified location.

### Steps to Change the Default Location for Java Object Files

1. Start IBM® Cognos® Configuration.
2. In the Explorer window, click **Local Configuration**.
3. In the Properties window, next to Advanced properties, click inside the Value box, and then click the edit button.
4. Click Add, and then type the following property name in the Name box:
   - `emf.webservice.objs.folder`
5. In the Value box, type the required folder location.
   **Note:** The location must be accessible to the server user.
6. Click OK, and save your changes.
7. Restart the services.

### Registering the Domain Name

You must register the domain name for the web service in the IBM® Cognos® Application Firewall (CAF) using IBM® Cognos® Configuration.

**Steps**

1. Start IBM® Cognos® Configuration.
2. In the Explorer window, under **Security**, click **IBM Cognos Application Firewall**.
3. Add host and domain name to the IBM® Cognos® list of valid names:
   - For the Valid domains and hosts property, click the value and then click the edit button.
   - In the Value - Valid domains or hosts dialog box, click Add.
   - In the blank row of the table, click and then type the host or domain name.

4. Click OK, and save your changes.

5. Restart the services.

Run an Agent

You can run an agent in IBM® Cognos® Connection when you want to check for event instances and perform tasks if those events occur.

For example, an agent is created to send an e-mail to sales staff in a particular region when they reach 75 percent of their sales quota for the month. The agent prompts for the sales region. A sales manager specifies Spain, and e-mails are sent only to sales staff in Spain.

Run an agent manually if you do not want to wait until it runs according to a schedule (p. 55).

You must have execute permission to run an agent. You must have traverse permissions for the folder that contains the agent.

If you want to ensure that every event instance is assigned a status of new when the agent runs, remove previous event instances by resetting the event list (p. 62).

Steps

1. In IBM® Cognos® Connection, in Public Folders or My Folders, click the run with options button on the actions toolbar next to the agent you want to run.

2. Under Time, click Now or click Later to specify a later date and time.

3. If you want the agent to prompt for values and filter the results it retrieves, under Prompt Values, select the Prompt for values check box.

4. Click Run.

   You are prompted for values if the agent includes prompts or if you have access to multiple data source connections or signons.

5. If prompts appear, respond appropriately.

6. Click OK.

   The options that you specified override the default agent options only for the current run.

You can view the run history of the agent in IBM® Cognos® Connection. For more information, see the IBM® Cognos® Connection User Guide.
Remove Previous Event Instances for an Agent

If you want to ensure that every event instance is assigned a status of new the next time that an agent runs, remove previous event instances by resetting the event list.

You may want to reset the event list if you edit the event condition such that it no longer makes sense to compare the current event list with the previous one. Resetting the event list can also help you to test the behavior of the agent when it detects new items.

Before you can reset the event list, you must define an event condition (p. 32). You must also run the agent (p. 61) at least once.

Step

- To remove previous event instances for an agent, from the Actions menu click Reset event list.

Working With Agents in IBM Cognos Connection

You can continue to work with agents in IBM® Cognos® Connection.

You can view the run history of the agent, which shows when the agent ran and whether it ran successfully. If it did not run successfully, you can resubmit it.

You can create an agent view if you want to share the agent with another user. You can apply different properties to the agent view, such as prompt values. You can also run the agent as an owner. If you want to change the properties of an agent and do not need to retain an agent with the original properties, you can simply change the default agent properties.

You can make a copy of the agent if you want to use the copy as the basis for a new agent.

You can create a shortcut if you want the agent to appear in more than one location.

You can add yourself to the alert list for the agent. When you subscribe to an alert list, you receive an e-mail notification when the agent is run.

For more information, see the IBM® Cognos® Connection User Guide.
Chapter 4: Tutorial - Creating an Agent

This tutorial shows how the various tasks in creating an agent are related to each other. It shows that managing task execution rules is performed for each task in an agent, but that specifying an event condition is performed once for an agent.

Scenario
You are the Director of Sales at The Great Outdoors Company. The Finance department identified a problem with invoice payments. Analysis of warehouse data shows that a large proportion of late payments are by customers who returned damaged or faulty items and did not receive replacements. Customers tend to withhold payment for the entire order even if only one or two items are in dispute. They may even refuse to pay for other completed orders until the disputed order is resolved. Therefore, rapid resolution of the returns issues has a direct effect on cash flow. The Director of Finance asks you to establish a process that closely monitors data for problems with high rates of return and takes immediate action to resolve any problem it detects.

Solution
You decide to use IBM® Cognos® Event Studio to detect event instances and notify the people who must quickly resolve the issue.

You create an agent named high_returns_followup. The agent detects cases where the actual value of returned products is greater than the threshold value that the person running the agent defines. You include a parameter in the event condition to represent this threshold value. Initially, you concentrate on large return orders because they have the greatest effect on cash received. After you address problems with the largest returns, you monitor lower valued returns.

To provide sales representatives with customer contact information, you decide to add a report task that runs the Customer Contact report. The sales representatives can then quickly call the retailer and try to resolve the issue.

Before you can distribute the report, you require a sales manager to approve and sign it off as being accurate, so you decide to an approval request task.

When you add the e-mail task to distribute the report, you specify that the e-mail message be in HTML format. When you edit an HTML message, you can click a button that inserts a table. You list return values by order number in the table. Then you attach to the e-mail message both the report that you saved in the report task and the event list that shows the event instances for which the agent performed its tasks.

To create this example agent, perform the following tasks:

- Start Event Studio and select the Go Sales (query) package.
- Define a parameter named total_return_value_for_item (p. 64).
- Define a calculation named order_item_return_value_calc (p. 65).
Specify an event condition that contains the calculation and parameter (p. 66).

Add a report task that saves a report customized with contact information for the retailers who returned the products (p. 67).

Change the task execution rules for the report task (p. 68).

Add an approval request task that send the report to the sales manager for sign-off (p. 69).

Add an e-mail task that sends an e-mail to the sales representative for the returned product (p. 70). Attached to the e-mail is the approved report.

Change the task execution rules for the e-mail task (p. 71).

Add a news item task that publishes a dynamic headline that shows the current value of preventable returns (p. 72).

Schedule the agent (p. 73).

Save the agent (p. 73).

Run the agent (p. 74).

### Start IBM Cognos Event Studio

You want to start IBM® Cognos® Event Studio and ensure that your agent uses a data package that it can monitor for the events you want and that it can use to perform tasks.

You decide to use the Go Sales (query) package because it contains data items related to returned products, retailers, and order details.

**Steps**

1. In IBM® Cognos® Connection, from the Launch menu, click the Event Studio link.
2. In the Select a package window, click Go Sales (query).

Event Studio opens in a new window. The data items you can use are listed in the Insertable Objects area.

**Tip:** If you want to continue working in both Event Studio and IBM® Cognos® Connection, you can keep both windows open.

The next step in the creating an agent tutorial is to define a parameter.

### Define a Parameter

You want to define a parameter named total_return_value that you can insert into an event condition.

**Steps**

1. From the Insert menu, click Parameter.
2. In the Parameter name box, type
total_return_value_for_item

3. Click OK.

Tip: To see the parameter, in the Insertable Objects area, click the parameters tab.

The next step in the creating an agent tutorial is to create a calculation.

Define a Calculation

You want to define a calculation named total_return_value_calc that you can insert into an event condition. This calculation must determine the total value of each order returned.

Steps
1. From the Insert menu, click Calculation.
2. In the Name box, type order_item_return_value_calc
3. In the Expression box, do the following:
   • In the Insertable Objects area, click the functions tab and expand Summaries.
   • Click the total function item, and drag it to the Expression box.
   • In the Insertable Objects area, click the source tab and expand Returned items (query).
   • Under Returned items (query), expand Returned items.
   • Click the Return quantity measure item, and drag it to the Expression box.
   • After you insert the source item, type for.
   • Under Returned items (query), expand Order.
   • Click the Order number item, and drag it to the end of the expression.
   • After you insert the source item, type a closing parenthesis:

The calculation expression is defined as follows:

\[
total([\text{Returned items (query)}],[\text{Returned items}],[\text{Return quantity}])\text{for}[\text{Returned items (query)}].
\]

[Order],[Order number])

4. Click OK.

The calculation appears as a calculation icon on the data items tab.

The next step in the creating an agent tutorial is to specify an event condition.
Specify an Event Condition

You want the agent to detect cases where the actual value of returned products is greater than the threshold value that the person running the agent defines.

Also, you want to see what parameter value would return an event list of between 5 and 10 items from the current data.

Steps

1. Click the Detail tab.

2. In the Insertable Objects area, click the source tab.

3. Expand Returned items (query).

4. Under Returned items (query), expand Returned items.

5. Click the Return quantity measure item, and drag it into the expression box.

6. After the source item you just inserted, type
   > 0 and

7. On the data items tab, click the order_item_return_value_calc calculation that you defined previously (p. 64), and drag it to the end of the expression.

8. At the end of the expression, type a greater than symbol:
   >

9. Click the parameters tab, click the total_return_value parameter that you defined previously (p. 64), and drag it to the end of the expression.

10. At the end of the expression, type
    and

11. On the source tab, under Returned items (query), expand Return reason.

12. Click Reason description, and drag it to the end of the expression.

13. At the end of the expression, type
    in

14. To include only the description types you want, do the following:
   - On the source tab, under Return reason, click Reason description.
   - Above the Expression box, click the select value button.
   - In the Select Value window, use Shift+Click to select Incomplete product, Unsatisfactory product, and Defective product.
   - Click the insert button, and click OK.
The detail expression appears as follows:

\[ \text{[Return quantity]} > 0 \text{ and } \text{[order_item_return_value_calc]} > \text{[total_return_value_for_item]} \text{ and } \text{[Reason description] in ('Defective product', 'Incomplete product', 'Unsatisfactory product')} \]

15. Do the following to see whether an event list of between 5 to 10 items is returned when the total return value calculation exceeds $4000:

- From the Actions menu, click Preview.
- On the report viewer Prompt pages, in the Provide a number box, type 4000
- Click OK.

The next step in the creating an agent tutorial is to add a report task.

**Add a Report Task**

Sales representatives must ensure that items returned for a preventable reason are not returned again for the same reason. You want to save a report of customer contact information associated with the excessive rate of return event that you defined. Sales representatives can use this information to contact the retailer, discuss how to prevent future returns, and then take the appropriate action.

You decide to add a report task that runs the sample report named Customer Contact. When the agent runs the report task, the value of the Retailer name data item for each event instance is passed to the report output.

By adding an e-mail task, you can include additional information in the e-mail message that you cannot include using the report task.

**Steps**

1. In the I want to area, click Add a task.
2. Click Run a report.
3. Specify the report that you want to run:
   - Click Public Folders, and click Go Sales (query).
   - Click Event Studio Samples.
   - Click Customer Contact Report and click OK.
4. Under Options, click Set.
5. Specify the run options that you want:
   - Select the Override the default values check box.
   - Under Formats, select the PDF check box and ensure that none of the other check boxes are selected.
   - Under Delivery, select the Save check box, and ensure that Save the report is selected.
6. Specify the prompt values that you want:
   - In the Method column, click Use an item.
   - In the Insertable Objects area, click the source tab and expand Sales (query), Retailer.
   - Click Retailer name, and drag it to the Value box.

7. Save the agent (p. 73).

The next step in the creating an agent tutorial is to change the task execution rules for the report task.

**Change the Task Execution Rules for a Report Task**

The status of each event instance is obtained by comparing the event instances of the current run of the agent to those of the previous run. You want to specify which event statuses will cause the agent to perform the report task.

You know that for the event condition you specified, the Product name, Retailer name, and Order method data items have duplicate values in two or more event instances. However, because the Order number data item has a different value for each event instance, you choose it as the event key.

You decide that the report task that you added previously (p. 67) should be performed for both:

- new event instances
  New event instances are instances that are detected when the agent runs and were not previously detected.

- ongoing event instances in which the return quantity has changed
  Ongoing event instances are detected when the agent runs and have previously been detected. In this case, only ongoing event instances in which the return quantity has changed cause the report task to run.

**Steps**

1. In the summary area, click new report.
2. In the I want to area, click Manage the task execution rules.
3. Click the Event Key tab.
4. Click Include only selected items.
5. On the source tab, expand Returned items (query) and Order.
6. Under Order, click Order number, and drag it to the Event key box.
7. Click the Event Selection tab.
8. Under Select when to perform each task, select the New events and Ongoing events check boxes. This chooses the event status for which the report task is performed.

9. Click OK.

10. Save the agent.

The next step in the creating an agent tutorial is to add an report approval request task.

### Add an Approval Request Task

You require a sales manager to approve the accuracy of the report that you saved previously (p. 67) and sign it off before it is distributed to the sales representatives.

You decide to add an approval request task. When the agent is run, a task will be created within My Inbox in IBM® Cognos® Business Intelligence and notifications will be sent via e-mail to the potential owner and stakeholder identified for the task.

**Note:** When you add an approval request, the task execution is automatically set to sequential.

**Steps**

1. In the I want to area, click Run an approval request.

2. Click the source tab, and expand Sales (query).

3. Expand Sales Staff.

4. Click Manager Email and drag it to the Potential owners box.
   
   **Note:** You are automatically added as a stakeholder of the task.

5. In the Subject box, type

   Customer Contact Report for Approval

6. In the Body box, type:

   Please approve or reject the content of the attached report. If you approve this report it will be distributed to

7. To add the e-mail distribution list for the sales representatives to the message:

   - Click the source tab, and expand Sales (query).
   - Expand Sales Staff.
   - Click Email and drag it to the end of your message.

8. Save the agent.

The next step in the creating an agent tutorial is to add an e-mail task.
Add an E-mail Task

When the Customer Contact report has been approved by the sales manager, you want to notify sales representatives about orders that have a high rate of return.

You decide to add an e-mail task. You specify that the e-mail message use HTML format. When you edit an HTML message, you can click a button that inserts a table. You list return values by order number in a table. Then you attach to the e-mail message both the report that you saved previously (p. 67), and the event list showing the event instances for which the agent performed its tasks.

Note: The e-mail task will only execute if the approval request that you previously added is approved by the potential owner.

Steps
1. In the I want to area, click Add a task.
2. Click Send an email.
3. Click the source tab, and expand Sales (query).
4. Expand Sales Staff.
5. Click Email and drag it to the To: box.
6. In the Subject box, type
   Urgent: Please contact customer
7. In the Body box, type:
   Please contact your customer about the following returned order(s), and determine how to prevent it from happening again
8. Add a table to the Body message:
   • Click the insert table button.
   • Type 4 in the Number of columns box, type 2 in the Number of rows box, and click OK.
9. Type the column headings in the first row:
   • In the first cell, type
     Order Number
   • In the second cell, type
     Value of items returned
   • In the third cell, type
     Reason description
   • In the fourth cell, type
     Customer name (see attached contact information)
10. Select the heading row, and click the bold button \textbf{B}.

11. Enter data items in the second row:
   \begin{itemize}
   \item Click the source tab, expand Sales (query), then expand Order, and click \textit{Order number} and drag it to the first cell.
   \item Click the data items tab, click \textit{total_return_value_calc}, and drag it to the second cell.
   \item Click the source tab, expand Returned items (query), then expand Return reason, and click \textit{Reason description} and drag it to the third cell.
   \item Expand Sales (query), then expand Retailer site, and click \textit{Retailer name} and drag it to the fourth cell.
   \end{itemize}

12. In the Body box, after the table, type
   \begin{quote}
   Thanks, the GO Sales Customer Loyalty Team
   \end{quote}

13. Click Attach, and click Attach the event output.

14. Click Attach, and click Attach the report Customer Contact.

15. Save the agent.

The next step in the creating an agent tutorial is to change the task execution rules for the e-mail task.

\section*{Change the Task Execution Rules for an E-mail Task}

The status of each event instance is obtained by comparing the event instances of the current run of the agent to those of the previous run. You want to specify which event statuses will cause the agent to perform the e-mail task.

You know that for the event condition you specified, the Product name, Retailer name, and Order method data items have duplicate values in two or more event instances. However, because the Order number data item has a different value for each event instance, you choose it as the event key.

You decide that the e-mail task you added previously (p. 70) should be performed only for event instances that did not appear in the event list the last time the agent was run.

\textbf{Tip:} You can add multiple tasks to an agent and use task-level filters to include only those events that satisfy a Boolean condition. See "Example - Task-Level Boolean Filter" (p. 18).

\section*{Steps}

1. In the summary area, click new message.

2. In the I want to area, click Manage the task execution rules.

3. Under Select when to perform each task, select the New events check box and ensure that none of the other check boxes are selected.
4. Click OK.

5. Save the agent.

The next step in the creating an agent tutorial is to add a news item task.

Add a News Item Task

The customer fulfilment manager wants to be informed of the current preventable returns. However, he does not always check his e-mail. He prefers to view important updates on a Web dashboard that he checks regularly.

You decide to add a news item task that updates a headline with the total value of returns that are preventable. That is, you publish the values of products returned because they are incomplete, defective, or unsatisfactory.

Steps

1. Create a folder named High Returns.
   - In IBM® Cognos® Connection, click the new folder button.
   - In the Name box, type High Returns
   - Under Location, click Select My Folders.
   - Click Finish.

   The High Returns folder appears in My Folders.

2. In IBM Cognos Event Studio, in the I want to area, click Add a task.

3. Click Publish a news Item.

4. In the Headline box, type Preventable Returns for Large Value Individual Items.

5. Drag the calculation data item total_return_value_calc to the end of the text you just typed.

6. Under Link to, choose what you want to link to:
   - Click Select an entry.
   - Click Public Folders, and click Go Sales (query).
   - Click Event Studio Samples.
   - Click Customer Contact Report and click OK.

7. Under News list location, click Select a location, go to the High Returns folder in which the news item will be published and click OK.

8. Under Run this news item for the events, review the event status that will cause the news item to be published.
9. From the File menu, click Save.

When the agent performs the news item task, it publishes the news item to the My Headlines folder. The description text appears when you set your IBM® Cognos® Connection preferences to use the details view. The screen tip appears when you pause your pointer over the icon for the entry in the news list location.

The next step in the creating an agent tutorial is to schedule an agent.

Schedule an Agent

When the excessive rate of return event you defined occurs, significant potential revenue has already been lost. Following up on returned products increases your shipping charges and administration fees. However, the most important impact of returned products is that they can reduce customer loyalty and decrease your future sales. Therefore, it is important that you respond quickly to an event instance as soon as it occurs.

You decide that you can provide a timely response to event instances by monitoring the data hourly. You also decide that $17,000 is an appropriate threshold value for this initial schedule.

Steps

1. In the I want to area, click Schedule the agent.
2. Under Frequency, click By Day, and ensure that the frequency is Every1 hour(s).
3. Under Start, select tomorrow’s date, and specify the time as 9:00 AM.
4. Under End, click No end date.
   Tip: You can edit the schedule later if you want to add an end date.
5. Under Prompt values, select the Override the default values check box, and then click Set.
6. On the prompt page, in the Provide a number box, type 17000
7. Click OK twice.

A schedule is created and the high_returns_followup agent runs hourly, starting tomorrow at 9:00 a.m.

The next step in the creating an agent tutorial is to save an agent.

Save an Agent

You want to save the agent in My Folders. You also want to give the agent a meaningful name and description so that you can easily distinguish it from other agents.

Steps

1. From the File menu, click Save.
2. If this is the first time you are saving the agent, in the Save As dialog box, describe the agent:
   - In the Name box, type high_returns_followup
   - In the description field, type This agent checks for orders that have a high value of returned products. It then sends a report by e-mail to the appropriate sales reps so that they can contact the retailers and prevent future returns.
   - Ensure that the Location is set to My Folders.
   - Click OK.

The agent high_returns_followup appears in My Folders, next to an agent icon.

The next step in the creating an agent tutorial is to run an agent.

**Run an Agent**

You decide to run the agent immediately to test the results.

If you want to successfully run the agent described in this tutorial, you must first perform the tasks in all the other examples. For more information, see "Tutorial - Creating an Agent" (p. 63).

**Steps**

1. In IBM® Cognos® Connection, in My Folders, click the run with options button on the actions toolbar next to the high_returns_followup agent.
2. Under Time, click Now.
3. Under Prompt Values, select the Prompt for values check box.
4. Click Run.
5. On the Prompt page, in the Provide a number box, type 17000
6. Click OK twice.

The high_returns_followup agent runs using the prompt value you entered. To see the results of the run, you can review the run history of the agent. For more information, see the IBM® Cognos® Connection User Guide.
Chapter 5: Troubleshooting

You can find more troubleshooting topics in the Troubleshooting section of the IBM® Cognos® Administration and Security Guide.

A Report Link in an Email Notification Does Not Work

If a report link in an email notification does not work, the Gateway URI may not be configured correctly.

You must change the host name portion of the Gateway URI from localhost to either the IP address of the computer or the computer name. If the URL in the email contains localhost, remote users cannot open the report.

The Page Cannot Be Found Error Appears When Viewing Report Outputs from Email Links

When a report is distributed by email, no error message appears if the report output from the email link is not available. This can occur when the output is deleted or when the user does not have permissions to the report. Instead, the error The Page Cannot Be Found appears.

You are unable to view the report output from the email link when Allow Anonymous Access is set to True and when the Anonymous user does not have access to the report output.

When you run a secured report from an email link and when Allow Anonymous Access is set to True, a passport is automatically issued to the Anonymous user. The Anonymous user is not prompted to log on and is unable to view the report output.

Metadata Change in Oracle Essbase Not Reflected in Reports and in the Studios

When there is a metadata change on the Oracle Essbase server, the change is not immediately reflected in the metadata tree in the studios. In addition, when a report is run, the report does not pick up the republished changes.

To view the new structure, you must restart the IBM® Cognos® Content Manager server.

Errors When Running Web Service Tasks

When running a Web service task, you may encounter one of the following errors:

CNC-ASV-0001 The Following Agent Service General Error Occurred: java.lang.StackOverflowError
CNC-ASV-0007 An error occurred with the agent Web service task.
To prevent this error, modify the file bootstrap_win32.xml in the bin folder to add the ThreadStack-Size (Xss) parameter:

**Steps**

1. Open the `c10_location\bin\bootstrap_win32.xml` file in an XML editor.

2. Add the following parameter to the file:

   ```xml
   <process name="catalina"> ...
   <param condName="${java_vendor}" condValue="Sun">-XX:MaxPermSize=128m</param>
   <param condName="${java_vendor}" condValue="IBM">-Xss128m</param>
   ```
Glossary

**agent**
The object type created and edited by Event Studio. An agent contains the event condition and the associated tasks to perform.

**burst**
To create several report results by running a single report once. For example, the user can create a report that shows sales for each employee, and run it once, sending different results to regional managers by bursting on region.

**event**
A change to a state, such as the completion or failure of an operation, business process, or human task, that can trigger a subsequent action, such as persisting the event data to a data repository or invoking another business process.

In Cognos Real-Time Monitoring and Cognos Now!, a row or a series of rows of data.

**event key**
A combination of data items that uniquely defines an event instance. Identifying an event instance enables the agent to determine if it is new, ongoing or stopped.

**event list**
The set of detected event instances evaluated by the task execution rules to determine which agent tasks should be performed.

**job**
A group of runnable objects, such as reports, agents, and other jobs that the user runs and schedules as a batch.

**news item**
A single entry in a Really Simple Syndication (RSS) compatible format. It can include a headline, text, and a link to more information. A news item task in an agent can be used to create news items for display in a Cognos Connection portlet.

**package**
A subset of a model, which can be the whole model, to be made available to the Cognos server.

**really simple syndication**
An XML file format for syndicated web content that is based on the Really Simple Syndication specification (RSS 2.0). The RSS XML file formats are used by Internet users to subscribe to Web sites that have provided RSS feeds.
**rich site summary**
An XML-based format for syndicated web content that is based on the RSS 0.91 specification. The RSS XML file formats are used by Internet users to subscribe to Web sites that have provided RSS feeds.

**task**
An action performed by an agent if the event status meets the task execution rules. For example, an agent can send an e-mail, publish a news item, or run a report.

**task execution rule**
A user-specified option within an agent that determines which statuses and values cause a task to be run. It determines which tasks to execute for each event instance.
Index

A
adding an approval request task example, 69
adding an email task example, 70
adding a news item task example, 72
adding a report task example, 67
adding a task to an agent, 34
agent, 18
  creating, 31
  prompting, 19
  running, 61
  scheduling, 55
  specifying default options, 56
  testing, 59
  view, 19
  working with in IBM Cognos Connection, 62
agents
  definition, 77
agent task
  adding, 40
alert list
  enabling user watch items, 56
approval request task
  adding, 41
audience of document, 7

B
bursting
  definition, 77

C
calculation
  defining, 33
changing the task execution rules
  example, 68, 71
CNC-ASV-0001 error, 75
Cognos Connection, See IBM Cognos Connection
condition
  specifying for event, 32
content area, 14
content maintenance task
  adding, 50
creating an agent
  example, 63
Customer Contact sample, 24

data
  previewing, 53
database update task
  adding, 47
data item
  defining, 33
data items tab, 15
default options for an agent
  specifying, 56
defining a calculation
  example, 65
defining a parameter
  example, 64
deleting a task, 58
description of product, 7
diagram
  Event Studio window, 14
dynamic address, 22

e-mail address
  adding to agent alert list, 56
generated from data items, 22
e-mail notification, 21
e-mail subject
  generated from data items, 22
e-mail task
  adding, 34
error messages
  CNC-ASV-0001, 75
  java.lang.StackOverflowError, 75

Licensed Materials – Property of IBM
© Copyright IBM Corp. 2005, 2010.
Index

The Page Cannot Be Found, 75

event, 16
  condition, 32
  instance, 16
  key, 17
  list, 17
  status, 17

event condition
  modifying, 58
  specifying, 32

event instances
  removing, 62

event keys
  definition, 77

event list
  resetting, 62

event lists
  definition, 77

events
  definition, 77

Event Studio
  CNC-ASV-0001 java.lang.StackOverflowError, 75

execution rules, 17

export task
  adding, 49

expression
  specifying for event condition, 32

functions tab, 16

Great Outdoors Company
  samples, 22

IBM Cognos Business Insight, 11
IBM Cognos Business Insight Advanced, 12

IBM Cognos Connection
  working with agents, 62

import task
  adding, 49

Insertable Objects area, 14

I want to area, 14

J
  jobs
    definition, 77
  job task
    adding, 39

M
  metric task
    adding, 51
  migration task
    adding, 52
  modifying a task, 58
  multiple event instances
    effect on approval requests, 22
    effect on email messages, 22
    effect on notification requests, 22

N
  news item notification, 22
  news items
    definition, 77
  news item task
    adding, 35

  notification methods, 20
  notification request task
    adding, 45

options
  specifying defaults for agent, 56

Oracle Essbase
  changes, 75

order of tasks
  changing, 57

P
  packages
    definition, 77
  parallel tasks, 57
  parameter
    defining, 33
  parameters tab, 16
  planning task
    adding, 51
  previewing data, 53
prompts
  passing to agent, 19
prompt values, 33
purpose of document, 7

Q
quick tours, 7

R
removing previous event instances, 62
report
  customizing for report task, 38
report distribution
  report link in email notification does not work, 75
report options
  changing, 38
report task
  adding, 37
resetting the event list, 62
Returns Agent sample report, 24
RSS
  definition, 77
run history tab, 16
running an agent, 61
  example, 74

S
samples, 22, 23
saving an agent
  example, 73
scheduling an agent, 55
  example, 73
sequential tasks, 57
SOAP response error when viewing report outputs from
  email link, 75
source items, 11
source tab, 15
specifying an event condition
  example, 66
starting Event Studio, 64
status of events, 17
stored procedure
  running with an agent, 47
studios
  Oracle Essbase changes, 75
summary area, 14

T
task, 19
  adding to agent, 34
deleting, 58
  frequency, 20
  modifying, 58
task execution rules, 17
  definition, 78
  modifying, 58
  specifying, 52
tasks
  changing order performed, 57
definition, 78
testing an agent, 59
troubleshooting, 75

U
unique identifier of event instance, 17
user subscription to alert list
  enabling, 56

V
validating an agent, 59
viewing reports
  SOAP response error when viewing from email
    link, 75

W
watch items to alert list
  enabling, 56
Web service task
  adding, 47
  preparing to run, 59
window
  Event Studio, 14